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1—Installing and Getting Started

Welcome to Extensis Fetch™. Your Extensis Fetch software is a
simple but efficient cataloging tool that will organize all your
creative work into a browsable on-line library. Fetch allows you to
take images—graphics, presentations, movies, sounds, and other
digital media files—that you or members of your workgroup create
every day, and put them into a common visual catalog. Using the
catalog you can then view, edit, copy, and retrieve the files from the
catalog and transfer them to other documents. And you can accomplish
all this regardless of format, location, or the applications that created
the files. Fetch works seamlessly with you from the beginning to the
end of a project, fitting neatly into your flow, helping you find all your
finished work—and all the pieces that went into it!

Inside the catalog, Fetch stores thumbnail images rather than storing
full documents and image files, creating pointers to the original files.
Because Fetch does not store the files themselves, using a catalog is
very fast—and very efficient.

A single catalog can contain over 100,000* items. To each item in a
catalog, you can add:

  • an unlimited number of keywords (each up to 31 characters long)
that let you easily search a catalog.

  • a description (up to 32,000 characters long) that lets you store
important or useful information about the file.

In a workgroup setting, you can allow all users full access to all
functions, or you can designate catalog administrators to create,
maintain, and control access to catalogs for the entire workgroup. With
Fetch installed on their computers, members of your workgroup can
simultaneously search, view, and use items from catalogs whose source
files are located on one or many network servers or shared volumes.

*Note: As the number of items in catalogs increases, common opera-
tions will require more memory and time to complete.

Equipment Needs

To install and use Extensis Fetch, you’ll need a 68030-based Macintosh
or newer (including Power Macintosh and compatibles), 8MB of RAM
minimum, and System 7.5 or later.

The Fetch application requires a minimum of 4M of  RAM. If you plan
to catalog and view files that are typically quite large (for example,
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compressed images or KODAK Photo CD images), you’ll need 5MB of
RAM or more for the Fetch application.

For full functionality, the following files must be installed and enabled:
QuickTime 2.5, Macintosh Easy Open, and QuickDraw 3D (Power
Macintosh only). For more information, refer to the following page
“Making new extensions available.”

Installation

Before installing, turn off any anti-virus software and extensions,
except for your CD-ROM extensions. Then restart your computer.

To install Extensis Fetch

1. Insert the disk that came with your product.

If you received a CD-ROM version, you will notice that other Extensis
products are available for you to install. These products are full
working versions of Extensis products that you can run in Demo
mode.

2. Double-click the installer icon.

The Introduction dialog box appears.

3. Click Continue.

The Welcome dialog box appears. Release notes and special
instructions are displayed in this window. It is important that you
read these release notes since they contain information not included
in the manual. You should save or print these release notes before
continuing the installation.

4. Click the Continue button.

The Installation dialog box appears.

5. Click the Install button.

The Disk Selection dialog box appears. The dialog box requests that
you select the disk on which you want the Extensis product installed.

6. Select a disk.

 Once a disk has been selected, you will need to locate the folder
into which you want to install Extensis Fetch.

7.  Click the install button.

 Once installation is complete, the successful installation dialog
appears. The installer will prompt you to restart your computer if
necessary.
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Making new extensions available

After installation is complete and before starting Fetch for the first
time, the installer will prompt you to restart your computer to enable
extensions such as QuickTime, Fetch Translation files, and QuickDraw
3D (for Power Macintosh). Doing so will allow you to use Fetch with
all its features.

Fetch provides file filters (translation files) to let you catalog various file
types in Fetch. These filters are recognized and used by Macintosh Easy
Open. Easy Open is provided with System 7.5, but if you are not currently
using it, you will need to add this extension to your Extensions folder,
restart your computer, and set “Automatic Document Translation” ON.
(While Easy Open adds to your Fetch features, it also provides you with
alternatives for opening and converting files in your system—for more
details refer to the documentation that came with your system software.)

After you start using Fetch, an Extensis Fetch™ Preferences folder will
be created and added to the Preferences folder in your System folder.
This new folder contains three files:

• Extensis Fetch™ Exclusions—a file that contains the names of files
you do not want to catalog.

• Extensis Fetch™ Key—a file that contains the serial number that
you enter the first time you start Fetch. If you delete this file,
Extensis Fetch prompts you to enter the serial number again the
next time you start the application.

• Extensis Fetch™ Prefs—a file that contains any settings you
change using the “Preferences…” command in the Edit menu and
any search definitions you create using the “Define…” command
from the Search menu.

Personalization and Registration

It is important to register your copy of Extensis Fetch so we can
provide you with service. Registered users of Extensis Fetch are
eligible for technical support, information regarding new versions,
products, discounts and special offers on new products.

Extensis Fetch includes electronic registration, so registering has never
been easier! The first time you launch Fetch after installing it, the
Extensis Fetch Personalize dialog box appears. To personalize Fetch,
type your name, company and Fetch registration number. Your product
registration number is located on your Extensis Fetch manual. If you
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choose not to personalize your copy, Fetch will run in a 30-day
demonstration mode. A dialog box will remind you of how many days
are remaining in the demonstration mode.

Once you have personalized Fetch, a dialog box appears, asking if you
would like to register. To register, click the Register Extensis Fetch
button; an electronic registration screen appears. After you’ve com-
pleted the registration screen, a Market Research screen and a System
Configuration screen will follow. The Market Research screen asks
basic questions that enable us to better understand your needs. The
System Configuration screen provides a “snapshot” of your system
configuration that enables Extensis to support you more effectively.
Sending the Market Research and System Configuration information is
optional. If you do not wish to send this information to Extensis, check the
checkbox at the bottom of these screens.

To use electronic registration, you must have a modem connected to
your computer. Fetch will dial the number automatically, and the call
is toll-free. If you do not have a modem, you can print the registration
sheet and register either by faxing it to (503) 274-0530 or drop it in the
mail in the postage-paid envelope provided. If you don’t have access
to a modem or printer, you can still register by filling out the
registration sheet located at the end of this manual.

Technical Support

For questions regarding Extensis Fetch, please first refer to this manual,
which describes the features and basic operations. If you have a
question or problem that is not addressed in the manual, technical
support is available by calling (503) 274-7030, Monday through Friday,
between the hours of 8:00 a.m to 5:00 p.m. Pacific time.

When calling technical support, please be at your Macintosh and have
the following information available: your Extensis Fetch registration
number, your Macintosh configuration and your question or a
description of the difficulty you’re experiencing—what specifically
occurs and when. Take note of any displayed error numbers or
messages and any other information you think may be relevant.

Tip

We can also be reached via fax at
(503) 274-0530, or through the
online services listed below.

CompuServe:   70242,33
America Online:   EXTENSIS
Internet:   support@extensis.com
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Cataloging your files—getting started

Now that you’ve installed Fetch, you’d probably like to catalog one or
more of your files, to see how Fetch displays them. (If you don’t have
any files to catalog yet, you can look at the sample catalog. See “Using
the sample catalog.”)

Cataloging your files is as easy as drag-and-drop:

1. Drag and drop selected files/folders.

Select a file or folder and drag it over the Fetch application icon.
When the icon is highlighted, release the file or folder.

If you have not already started Fetch, the application is automati-
cally launched and the product screen appears for a moment.

2. Create a new catalog.

After the product screen, a prompt appears, asking you to open an
existing catalog or create a new one. Since you have not yet created
a catalog, click “New.”

3. Determine the name and location of your catalog.

When you create a catalog, Fetch creates a catalog file, which it stores
on your hard drive. In the file location dialog box, which appears next,
type in a name for your catalog and choose its location. Click “Save”
to create your new catalog on your hard drive.

Suggestions

We’d love to hear your comments about Extensis Fetch! For your
convenience, a suggestion sheet is included at the end of this manual.
Please fax, mail, or e-mail your comments and suggestions to Extensis.
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4. Select the options you prefer.

Fetch presents you next with the Add/Update dialog box, which lets
you choose a variety of options when you catalog files. For most files,
the default settings should be fine. (For more information about
adding and updating options, see “Setting catalog update options.”)

For now, just click “Continue...”.

Next you’ll see a series of three status windows appear. The first
small window shows Fetch scanning the files and folders that you
dragged over the Fetch application icon. For a small number of
files, this window may appear for only a second or two.

The second, larger status window shows the files as they are being
added to the catalog. In this window, depending on the setting of
“Thumbnail Type(s)” in the Add/Update Options dialog box, you’ll
see either one or two pictures (or thumbnails) of each file. The
default setting shows the 32-bit thumbnail. (For more information about the
different types of thumbnails, see “Setting catalog update options.”)

       

After all your files have been cataloged an Add/Update summary
window. The “Added” line shows the number of files that were
cataloged. This number should correspond to the number of files
you dragged over the Fetch application icon. The “Updated” line
shows the number of files that were updated. Since you did not
update any files this time, this number should be zero.

Click “OK” to continue.

5. Find items in the catalog.

Now you’ll see the Find window. This window lets you search for
specific items in your catalog, using keywords that you have added
or keywords that have been automatically added, such as file name
and folder. (For more information, see “Searching through a
catalog” and “Organizing a catalog by adding keywords.”)

To view all the files you’ve just cataloged, click “Find All.”

Scanning Folders on:

Sunshine

Folders:  12

Files:  46
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6. View your files.

You should now see all the files that you cataloged in the Gallery
window. If you have cataloged files that do not have thumbnails
attached to them (such as text files), then you will see a file icon
instead of the thumbnail. (For help on attaching thumbnails to files,
see Chapter 5).

The thumbnails displayed in the Gallery window are only references
to the actual, or “source” files. The files themselves can be stored
anywhere. However, in order to accomplish certain tasks in Fetch,
you will need access to the source files.

Using the sample catalog

If you have not yet cataloged any of your own files, or if you’d like to
work with other file types (such as movies and sounds) that you may
not yet have, you can use the sample catalog to explore Fetch. During
installation, a Sample Catalog folder was placed in your Extensis Fetch
folder.

Before you use the sample catalog, you should update it to reflect the
new location of its source files (on your hard drive rather than on the
drive from which they were originally cataloged). If you do not update
the sample catalog, you will only be able to display thumbnails in the
Gallery window; you will not be able to preview the catalog items.

To update all Sample Catalog items at once:

1. Open the catalog by double-clicking on the Sample Catalog
icon.

The Find window appears before a catalog is displayed.

2. Click on “Find All” in the Find window.

This locates and displays all the items in the Sample Catalog.

3. Choose “Select All” from the Edit menu.

4. Choose “Update Now” from the Admin menu.

Fetch looks for a source file for each item in the catalog. If Fetch
cannot locate a file, it will prompt you to locate the file . Click
“Open” for each item.

5. Click “OK” after all the files have been located.
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Sources of information about Extensis Fetch

Name Description

Extensis Fetch User Manual A short manual that provides basic procedures, strategies, tips, and
shortcuts for using Fetch.

Balloon Help Detailed online information about individual commands and dialog
box options. Choose “Show Balloons” from the Help menu, then
move the mouse pointer to whatever item on the screen you want
information about.

Fetch Shortcuts An online summary of shortcuts for moving within and among
windows in Fetch. Choose “Fetch Shortcuts” from the Help menu on
the main menu bar.

ReadMe A text file that contain late-breaking information about Fetch that was
not available when this manual went to press. ReadMe contains
general program information. Double-click the file’s icon to read it
using SimpleText. We also recommend that you print these files and
keep them with your Extensis Fetch User Manual.

To update Sample Catalog items one at a time:

1. Open the catalog by double-clicking on the Sample Catalog
icon.

2. Click on “Find All” in the Find window.

3. Double-click on the thumbnail to preview the item you want.

4. When prompted, locate and open the file in the Sample Catalog
folder using the file directory dialog box that Fetch displays.

5. Click “Update” in the next dialog box.

6. Close the Preview window.

7. Repeat Steps 3-6 for each item in the Gallery window.

Where to turn next

Where you turn next in this user manual will depend on how you will
be using Extensis Fetch:

• If you will be primarily using catalogs created by someone else in a
workgroup, turn to Chapter 2, “Using Catalogs.”

• If you will be responsible for creating and managing catalogs either
for others or for yourself, turn first to Chapter 3, “Creating and
Managing Catalogs,” and then to Chapter 2.
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Chapter 2 describes how to start Extensis Fetch, open a catalog and
search for items, and then select, preview, and use those items in a
variety of ways. You’ll also learn how to “work smarter” using Fetch—
by setting appropriate startup options, using the Pasteboard window as
a temporary staging area, and creating collections of items called
projects.

This chapter assumes that you have an existing catalog with which to
work. If you do not, you can use the Sample Catalog installed in your
Extensis Fetch folder.

2—Using Catalogs

Starting Extensis Fetch and opening a catalog

Depending on your startup options, the catalog opens to one of the
two primary windows in Extensis Fetch: the Find window or the
Gallery window.

• In the Find window, you describe what you want Fetch to
display in the Gallery window.

• From the Gallery window, you can open one or more Preview
and Info windows that let you view more information about
individual items.

Double-click a catalog icon.Drag a catalog icon onto the Extensis
Fetch application icon until both icons
are highlighted, then release.

Double-click the Fetch icon, then
choose “Open…” from the File menu.
If you have a default catalog, double-
clicking the Fetch icon automatically
opens that catalog.

You can start Extensis Fetch and open a catalog in any of these ways:
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Find window: Lets you describe
what you want Fetch to display in
the Gallery window, whether you
want all the items in the catalog or
only items with a particular
filename, keyword, file type, or
volume. For more information on
searching, see “Searching through
a catalog.”

Primary windows in Extensis Fetch

Gallery window/Thumbnail view:
Displays the results of a search.
Shows a separate thumbnail
image of each item, with the
filename, file type, and volume
below the thumbnail. For more
information about the Gallery
window, see “Viewing search
results.”

Gallery window/Text List view:
Lists the items currently in the
window, one row for each item.
Also shows the thumbnail,
keyword list, and description for
the selected item. For more
information about the Gallery
window, see “Viewing search
results.”
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Preview window: Displays a full-
size preview of the item (unless
“scale-to-fit is selected). Fetch
must be able to locate the source
file before displaying the preview.
For more information about
previewing catalog items, see
“Previewing an item.”

Info window:  Displays all of the
information about an item that the
Fetch database contains or that
can be read from the source file.
To learn more about information
windows, see “Viewing item or
catalog information.”

Shortcuts

Open a catalog
(“Open…” on File menu)
Command + O

Open Find window
(“Find…” on Search menu)
Command + F

Open Gallery window
(“Gallery” on Window menu)
Command + R

Open Pasteboard window
(“Pasteboard” on Window menu)
Command + B

Change Gallery (or Pasteboard)
from Text List to Thumbnail view
(“Thumbnails” on View menu)
Command + T or
Double-click right end of
information bar

Change Gallery (or Pasteboard)
from Thumbnail to Text List view
(“Text List” on View menu)
Command + L or
Double-click right end of
information bar

Secondary windows in Extensis Fetch
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Two additional windows, the Catalog Info window and the Pasteboard
window, can also be useful as you work in Fetch. The Catalog Info
window provides summary information about the entire catalog. The
Pasteboard window is a temporary work space that you can use as a
staging area for items collected from different searches.

• For information on setting startup options, see “Setting preferences.”

• For more information about the Catalog Info window, see “Viewing
item or catalog information.”

• For more information about the Pasteboard window, see “Using the
Pasteboard window.”

Note: Whenever the pointer appears followed by two periods, like this  ,
you can double-click to open a dialog box or another window that is
relevant to the element you are currently pointing to.

Converting Fetch v1.2 Single-User catalogs

If you have a catalog that was created using the single-user version of
Fetch 1.2, you will need to convert it before you can use it in Fetch 1.5.

Note: Once converted, the catalog cannot be directly read by the
single-user version of Fetch v1.2.

To convert a Single-User catalog for use in Fetch 1.5

1. Choose “Convert…” from the File menu in Fetch.

2. In the file open dialog box, select the Single-User catalog that
you want to convert. Click “Open.”

An alert will be displayed, warning you that you will no longer be
able to read this catalog in the single-user version of Fetch 1.2.

3. To convert the catalog, click “OK.”

Searching through a catalog

Use the Find window to tell Extensis Fetch which catalog items you
want to see. You can use a variety of search parameters, including
Keyword, File Name, File Type, and Volume, including in your search
items that do or do not match a particular search criteria.

 You will probably find that you use different search strategies at
different times. For example:

• If your catalog is small or you’re looking for ideas, you might start
by looking through everything the catalog contains.
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• If your catalog is very large or you have a general idea of what
you’re looking for, you might want to look only at items related
to a particular subject or concept, or of a particular file type.

• If you’re in the final stages of a job, you probably know exactly
what items you need.

Fetch displays the results of the search in the Gallery window.
Items from the most recent search completely replace the previous
contents, if any, of the Gallery window but leave the Pasteboard
window intact. Note that in a network environment, up to 50 users
can search the same catalog simultaneously.

To open the Find window (or bring it to the front if open):

Choose “Find…” from the Search menu.

Fetch opens the Find window and displays the description of
the last search carried out.

To display the entire contents of the catalog:

Click “Find All” in the Find window.

(Click “Clear” to change the “Find” button to “Find All” if
necessary.)

or  Select “Find All” from the Search menu.

To retrieve a particular set of items from the catalog:

Use the Find window as shown on the following page to
describe what you are looking for, then click “Find.”

Fetch lets you search for items by keyword, filename, file type,
or volume, using “does” or “does not” match the indicated
keyword or filename, and “is” or “is not” the indicated file type
or volume. When you search by keyword or filename, you can
specify text to match, contain, start with, or end with. When
you search by file type or volume, you choose from a menu of
the file types or volumes referenced in the catalog and in the
user’s preferences.

Shortcuts

Open Find window or bring it to
the front if already open
(“Find…” on Search menu)
Command + F

Expand Find window
(“More Choices” button)
Command + M

Reduce Find window
(“Fewer Choices” button)
Command + F

Open Find window, then clear
existing search
(“Clear” button)
Command + Delete

Open Find window, then display
entire catalog
(“Find All” on Search menu)
Command + ' (apostrophe)

Open Find window, then carry
out default search
(“Default” on Search menu)
Command + D

Repeat previous search
(“Previous” on Search menu)
Command + , (comma)

Save or edit a named search
(“Define…” on Search menu)
Command + K
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Find window when clear

Find window containing an active search description

In the small version of the window, you
can enter a single search description.

A Click here to make a search
description active.

B Choose an attribute: filename,
keyword, file type, or volume. (The
volume need not be mounted before
a search. A mounted volume is a
storage device recognized by the
system and is available for reading
and/or writing information to.)

C Modify the chosen attribute. For a
keyword or file name, the “does/
does not” option combines with item
“D” options (“match,” “starts with,”
etc.). The option “is/is not” is for file
type and volume name attributes.

D With item “C,” modifies keyword
and file name attributes. Options
are “match,” “start with,” “contain,”
or “end with” for a keyword or
filename search.

E For a keyword or filename search,
type a word or part of a word here.

F Expands the Find window to its
larger form (shown below).

G Click here to clear and un-check the
search description.

H Click here to start the search. Button
name is “Find All” if no description is
checked. Otherwise, it’s “Find.”

Use the expanded Find window for a more complex search

CB

A

F G H

E

A

B

D

A

F

C

Use the small Find window for a simple search

In the expanded Find window, you can
give Fetch as many as four search
descriptions to combine in a single
search. Click “More Choices…” in the
small Find window to display this larger
version of the window.

A Check each box in turn to start
another search description.

B Choose “and” to narrow the search,
“or” to broaden it.

C Click here to reduce Find window to
its smaller form.

CB ED

HG
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Streamlining your searches

Extensis Fetch has several options that can help you search through
a catalog quickly and effectively. For example, you can:

• Choose the most efficient searches for Fetch to carry out.

• Name and save frequently used searches (to save yourself from
having to re-enter the descriptions each time).

• Customize the default search that Fetch carries out whenever
you open a catalog or choose “Default” from the Search menu.

Searching more efficiently

When you search on “Keyword” or “File Name,” choose
“matches” from the modifier popup menu for the fastest searches,
or “starts with” for searches that are nearly as fast. These searches
are always faster (more efficient) because Fetch uses indexes built
into the database.

Other types of searches may be a little slower because Fetch must
examine every entry in the database:

• Searching on file type or volume is slower when there is a large
number of items that match what you are looking for.

• Searching on keyword or filename using “contains” or “ends
with” can be slower when the catalog is large.

Volumes referenced in the catalog need not be mounted before you
search.

Saving search definitions

If you routinely use a particular set of items in a catalog, you can
name and save a search definition that retrieves those items.

Your named searches appear on the Search menu below the
predefined searches “Default” and “Previous.” Whenever you want
to carry one out, choose its name from the Search menu. You can
save up to 29 defined searches.

Note: In a network environment, each user can create up to 29
personal search definitions that are not visible to other users.

Shortcuts

Open “Definitions” dialog box
(“Define...” on Search menu)
Command + K

Carry out default search
(“Default” on Search menu)
Command + D

Open “New Definition” dialog
box
(“New” button in “Definitions”
dialog box)
Command + N

Delete a definition
(“Delete” button in “Definitions”
dialog box)
Command + D

Rename a definition
(“Rename” button in “Definitions”
dialog box)
Command + R

Open “Edit Definition” dialog box
(“Edit” button in “Definitions”
dialog box)
Return

Close the “Definitions” dialog
box (“Done” button in “Defini-
tions” dialog box)
Command + Return

Tip

To quickly search for all items
with a particular keyword, open
the Catalog Info window, locate
the keyword in the keyword list
(you will also see how many
items include that keyword), then
double-click the keyword. Fetch
will display the Gallery window
with all the items using that
keyword. To return to the
Catalog Info window, double-
click on the Gallery window’s
upper left corner, directly on the
item count.
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To define and save a search:

1. Choose “Define…” from the Search menu.

2. In the “Definitions” dialog box, click “New.”

3. In the “New Definition” dialog box:

• Type a name for the new definition, then enter one or more
search descriptions just as you would in the Find window. The
dialog box initially contains the descriptions from the current
contents of the Find window.

• Check “Find Automatically” if you want Fetch to carry out the
search automatically when you choose its name from the Search
menu. Leave this option unchecked if you want Fetch to simply
open the Find window and display the search description.

4. Click “OK” to return to the “Definitions” dialog box, then click
“Done” to close the dialog box and save the search definition.

Fetch stores the search definition you just created in its Preferences
file. You can share your search definitions with other users by
providing them with a copy of this file. You will find the Extensis
Fetch™ Prefs file in the Extensis Fetch™ Preferences folder in the
Preferences folder of the System folder.

You can also use the “Define…” command to rename or to remove
search definitions from the list, or to edit any of the searches.

Using the default search

You can use the “Define…” command to edit the default search
definition so that it retrieves the items you use most often. Fetch carries
out the default search the first time you open a catalog after starting the
program or whenever you choose “Default” from the Search menu.
Change the definition as often as you wish to reflect your current needs.
You can edit the default search, but not rename or delete it.

For more information about setting a default catalog or project, see
“Setting preferences.”

Viewing search results

Extensis Fetch displays the results of a search in the Gallery window.
You can see the Gallery window in Thumbnail view (for visual
browsing) or Text List view (for more information). In either view, you
can scroll and select items to preview, print, edit, or use in other
documents.

Searches on names without an ellipsis
are carried out automatically. Searches
on names with an ellipsis open the Find
window and display the search
description.
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To do this… Follow this procedure…

Reorder all items in the window Choose one of the “by” commands from the View menu. The “by” commands
allow you to reorder the items by the order they were entered into the catalog,
filename, file type, volume, or folder.

Select an item Click its thumbnail. Or click the text below the thumbnail. To add another item
to the selection, press Command + click the thumbnail. To select all items
between the last and current item, press Shift + click the thumbnail.

Preview an item Double-click the thumbnail. Or select the item, then press Return or choose
“Preview” from the Item menu (Command + J). For faster scrolling and
zooming of still images with G-World, hold down the G key while previewing.

Display an item’s information Double-click the text below the thumbnail. Or select the item, then
window choose “Get Info” from the Item menu (Command + I).

Edit an item’s source file Press Option + double-click the thumbnail. Or select the item, then choose
“Edit Original” from the Item menu (Command + G). To edit the source file in
an application other than the one last associated with its file type and creator,
press Option + Command + G.

Copy the item into another Select the item, then choose “Copy” from the Edit menu (Command + C).
document The selected item is stored on the Clipboard and is available for pasting into

another document. If the item is very large and your RAM is limited, you may
not be able to copy the item onto the Clipboard.

Thumbnail view shows a small thumbnail
image and minimal text information for
each item in the window. Resize the
window to see more or fewer thumbnails
at once. Scroll to see thumbnails not
currently visible.

A Displays the name of the open
catalog.

B Displays the number of items found
from the latest search. Double-click
here to open the Catalog Info window.

C Displays the status of the latest
search. Double-click here to open the
Find window.

D Press Option + click here to make the
window fill the screen.

E Double-click here to change to Text
List view.

Thumbnail view

Working in Thumbnail view

C

B

A

E

D
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To do this… Follow this procedure…

Reorder all items in the window Click a column heading. Or choose one of the “by” commands from the View
menu. The default is the order in which the items were added to the catalog.
Note: Gallery list reverts to “view by order” after each search.

Select an item Click its row in the list box. To add another item to the selection, press
Command + click the row. To select all items between the last and current
item, press Shift + click the row.

Preview an item Select the item; then press Return, double-click the thumbnail, or choose
“Preview” from the Item menu (Command + J). For faster scrolling and
zooming of still images with G-World, hold down the G key while previewing.

Display item’s information window Double-click a row in the list box. Or select the item, then choose “Get Info”
from the Item menu (Command + I).

Edit an item’s source file Select the item; then press Option + double-click the thumbnail or choose
“Edit Original” from the Item menu (Command + G). To edit the source file in
an application other than the one last used for similar files, press Option +
Command + G.

Edit an item’s keyword list Select the item, then double-click the word “Keywords” (Command + Y).

Edit an item’s description Select the item, then double-click the word “Description” (Command + U).

Copy item's source file onto Select the item, then choose “Copy” from the Edit menu (Command + C).
the Clipboard See also “Using an item in another document.”

Text List view shows a list box in the
top half of the window and the
thumbnail, keyword list, and description
of the selected item in the bottom half.
Scroll the list box to see items not
currently visible.

A Displays the name of the open
catalog.

B Displays the number of items found
from the latest search. Double-click
here to open the Catalog Info
window.

C Displays the status of the latest
search. Double-click here to open
the Find window.

D Press Option + click here to make
the window fill the screen.

E Double-click here to switch to
Thumbnail view.

Text List view

Working in Text List view

D

B

A C

E
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Previewing an item

If you would like to look more closely at any image or play sound or
movie items, open a Preview window. You can have as many Preview
windows open as memory allows (you may need to allocate more
memory to the Fetch program).

The names of all open Preview windows appear on the Window menu
together with the names of any open Info windows.

Before displaying an item in a Preview window, Extensis Fetch must be
able to locate the item’s source file—that is, the original file from
which the catalog entry was made. Fetch alerts you when a source file
cannot be located.

Note: In order to play movies and sounds, and view 32-bit color
thumbnails, you must have the QuickTime extension installed in your
System Extensions folder. QuickTime 2.5 is installed automatically
when you install Fetch.

To preview an item:

Select the item, then press Return (or Enter).

or

Double-click its thumbnail in the Gallery, Pasteboard, or Info
window.

or

Select the item, then choose “Preview” from the Item menu
(Command + J).

For faster scrolling and zooming of still images with G-World, open the
Preview window while pressing the G key.

Note: Some file types cannot be previewed. Among these are applica-
tions and Fetch catalogs and projects. For a complete listing of file
types recognized by Fetch and whether or not they can be previewed,
refer to “Adding a file type.”

The Preview window lets you display and manipulate an item in
various ways depending on the item’s type (image, sound, movie), as
described on the following pages.

Shortcuts

Open a Preview window
(“Preview” on Item menu)
Command + J or
Double-click thumbnail or
Select item, then press Return

Close active Preview window
(“Close” on File menu)
Command + W  or
Click close box

Close all active Preview
and Info windows
Option + click close box

Return to Gallery window
(“Gallery” on Window menu)
Command + R or
Double-click image

Return to Pasteboard window
(“Pasteboard” on Window menu)
Command + B
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A still image initially appears in a
Preview window either at actual size
(100% magnification) or scaled to fit a
window appropriate to your screen
size, depending on your preference
settings.

A File name of the item in the window

B File type

C Image size using the unit of
measure specified as the preference

D Current magnification

E Preview window cursor

F Partial-image selection area

G Resize box

Previewing still images

Working with a still image in a Preview window

A

B

C

D

E

G

F

To do this… Follow this procedure…

Select a portion of the image Drag a box around the area.

Select the whole image Choose “Select All” from the Edit menu (Command + A).

Increase magnification in window Press Shift + click image.

Decrease magnification in window Press Option + click image.

Return image to actual size Press Shift + Option + click image.

Increase both magnification Choose “Zoom In” from the View menu (Command + + (plus sign)).
and window size

Decrease both magnification Choose “Zoom Out” from the View menu
and window size (Command + - (hyphen or minus sign)).

Return image to actual size (100%) Choose “Actual Size” from View menu (Command + ` (accent)).
 and adjust window size to fit

Edit image’s source file Select the item; then press Option + double-click the thumbnail, or choose
“Edit Original” from the Item menu (Command + G). To edit the source file in
an application other than the one last used for similar files, press Option +
Command + G.

Copy image to Pasteboard window Choose “Copy to Pasteboard” from the Item menu (Command + M).

Copy image to the Clipboard Choose “Copy” from the Edit menu (Command + C). See also “Using an item
in another document.”

Open item’s information window Choose “Get Info” from the Item menu (Command + I). Or double-click the
information bar (above the image).
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A movie item appears in the Preview
window at its actual size with a standard
QuickTime control bar that lets you start,
stop, and step through the movie; select
frames; and control the volume. You
cannot resize a movie preview.

A Filename of the movie in the window

B File type (MooV)

C Movie drop-down menu

D Movie duration

E Badge (if control bar is not present)

F QuickTime control bar

G Volume control (if movie has sound)

H Play button

I Play bar

J Step buttons

Previewing movies

Working with a movie in a Preview window

B

E

A DC

IH J

F

G

To do this… Follow this procedure…

Select part of the movie Press Shift + drag within the play bar (selected frames appear highlighted).

Play or pause the movie Click the play button. Or press the spacebar. Or double-click the movie to play,
click to pause.

Control playback speed Press Control + click either of the step buttons.

Step forward or backward one frame Click the forward or backward step button, or press the right or left arrow key.

Jump to first or last frame Press Home or End.

Increase or decrease volume Click the volume control and adjust the slider. Or use the up and down
arrow keys.

Show or hide the play bar Press Tab.

Edit the movie’s source file Choose “Edit Original” from the Item menu (Command + G). To edit the movie
in an application other than the one last associated with its file type and
creator, press Option + choose “Edit Original…” (Option + Command + G).

Copy movie to Pasteboard window Choose “Copy to Pasteboard” from the Item menu (Command + M).

Copy movie to Clipboard Choose “Copy” from the Edit menu (Command + C). See also "Using an item
in another document."

Open movie info window Choose “Get Info” from the Item menu (Command + I).
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Previewing sounds

A sound item in the Preview window
appears and works much the same as
a movie item, except that there is no
visual component. The QuickTime
control bar lets you start, stop, and step
through a sound item; select part of the
sound item; and control the volume.

A Filename of the sound in the window

B File type

C Sound drop-down menu

D Sound duration

E QuickTime control bar

All of the Preview window shortcuts
and procedures for movies also work
for sounds.

A KODAK Photo CD image is a still
image file saved in a format compatible
with KODAK’s Photo CD imaging
software and hardware.

The Preview window for a KODAK
Photo CD image is the same as the
Preview window for other types of still
images, with the addition of a drop-
down menu that lets you display the
image at different resolutions and
rotate or flip the image. If you have
selected a part of the image, choosing
a command from this menu opens a
new Preview window.

Otherwise, all of the shortcuts and
procedures for working with a still
image also work for KODAK Photo CD
images.

Previewing KODAK Photo CD images

C

A

B D

E

Working with a sound in a Preview window

Working with a KODAK Photo Image in a Preview window
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A QuickDraw 3D image is a three
dimensional drawing that can be
cataloged with Fetch (available only on
Power Macintosh and like machines).

A Click the Views button to select a
particular view from the pop-down
menu.

B Views pop-down menu.

C Click the Zoom button to enlarge
(magnify) or reduce the image in the
window.

D Click the Rotate button to spin the
model in 3D space.

E Click the Move button move the
object around inside the window.

Previewing QuickDraw 3D images

To do this… Follow this procedure…

Edit image’s source file Select the item; then press Option + double-click the thumbnail or choose
“Edit Original” from the Item menu (Command + G). To edit the source file in
an application other than the one last used for similar files, press Option +
Command + G.

Copy image to Pasteboard window Choose “Copy to Pasteboard” from the Item menu (Command + M).

Copy image to the Clipboard Choose “Copy” from the Edit menu (Command + C). See also “Using an item
in another document.”

Copy current view of image Hold down the Option key and drag the image to the Finder (desktop).
as a picture clipping

Working with a QuickDraw 3D image in a Preview window

D ECB A
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Working with an item’s source file

Once you have identified a catalog item you want, you can work with it
from within the open catalog. For example, you can:

• Switch to another program to edit the source file (the original file to
which the catalog entry points).

• Move, copy, or delete the source file.

• Copy the item to the Clipboard, switch to another program, and then
paste the item in a document.

• Copy a reference (or pointer) to the Clipboard or send a reference
directly to a supporting application.

• Find out more information about the item.

• Print or fax thumbnails or the item itself.

Important: In a multi-user setting, be careful about moving or deleting
source files unless you are sure that the entire workgroup wants the
files moved or deleted.

To edit an item’s source file:

1. Select the item in the Gallery or Pasteboard window.

Or open a Preview or Info window that contains it.

2. Choose “Edit Original” from the Item menu.

Extensis Fetch remembers the name and location of the application
last used to edit the source file for any item of the same type and
creator. If necessary, you will be prompted to choose an application
and to specify where the application is located.

Fetch opens the application, which in turn opens the source file for
editing.

Note: When using the “Edit Original” command with a catalog or
project, Fetch will try to open the catalog or project using the
version of Fetch currently running. If the catalog or project is
incompatible with this version of Fetch, you will be able to select
the appropriate version from the “Edit Original” dialog box.

3. Make the changes you want, save the file, and quit the applica-
tion.

After quitting the editing application, you are returned immediately
to Fetch.

Tip

To edit the source file in an
application other than the one
that Fetch last associated with a
particular file type and creator,
press Option while choosing
“Edit Original…” from the Item
menu. The new application
becomes the one that Fetch will
remember until you change it
again.
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4. Choose “Update Now” from the Admin menu to update the
item’s thumbnail in the catalog.

Otherwise, the next time that you print, preview, edit, move, or copy
the item, you will be prompted to update it.

Note: You can eliminate this prompt by setting “Skip Add/Update
Dialog” option in the Preferences dialog box—for more details,
refer to the section “Setting preferences.”

To copy a source file:

1. Select the item in the Gallery or Pasteboard window and drag it
over the folder you wish to move it to.

Note: Drag-copying source files in Fetch works just like dragging
files in the Finder. That is, if you drag a thumbnail to a folder on the
same volume, the file is moved. If you drag it to another volume, the
file is copied. Holding down the Option key while dragging on the
same volume forces the file to be copied. “Copy Original…” makes
a copy of the source file, keeping the link between the catalog item
and the original copy only.

2. If you are not drag-copying the item, after selecting it, choose
“Copy Original…” from the Item menu.

3. In the file directory dialog box, locate and open the folder where
you want the copy or the original to go.

4. Click “Save.” Fetch will then copy the source file into the
opened folder.
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To move a source file:

1. Select the item in the Gallery or Pasteboard window.

2. Choose “Move Original…” from the Item menu.

3. In the file directory dialog box, locate and open the folder where
you want the original to go.

4. Click “Folder.” Fetch will then move the source file into the
opened folder.

Note: “Move Original…” moves the source file from its current
location to the one you specify. If the source file is locked, “Move
Original…” will not move the file, but will instead make a copy of it
and move it to the new location.

Fetch does not automatically update the catalog after you move a file.
Instead, you must select the item and choose “Update Now” from the
Admin menu, or respond to the update prompt the next time you try to
print, preview, edit, or get information about the item.

To delete a source file:

1. Select the item in the Gallery or Pasteboard window.

2. Choose “Delete Original…” from the Item menu.

Be very careful about using the “Delete Original…” command to
delete source files. Files deleted in this way do not go into the Trash,
they are deleted immediately. Once you confirm the deletion within
Fetch, the files are deleted and cannot be recovered.

3. Click “Cancel” if you change your mind or “OK” to go ahead
and delete the file.

Important: Deleting the source file does not delete the item from
the catalog. You can, for example, scan a series of photographs,
catalog the scanned images, then delete the original files. You’ll
still have the catalog entries as a way of keeping track of the
original photographs. If you do decide to delete the catalog entries
as well, use the “Delete…” command on the Admin menu, or select
the item and press Delete.

You can also use the “Purge…” command on the Admin menu to
check whether or not Fetch can still locate the source file for a
catalog item, then delete the item if you want. For more information
about deleting and purging items, see “Maintaining a catalog.”
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Transferring Extensis Fetch catalog items to other documents

If the receiving application… Use this command… To transfer…

Supports “Place Apple Event” Send Reference… One or more whole items to any computer on the
network.

Is or is not Fetch-aware Copy A single item or the selected part of an item to
another application on the computer you are using.

Supports FETCH Clipboard format Copy Reference One or more whole items, with either text
(pathname to original file) or thumbnails, to
another application on the computer you are using.

Supports FETCH Drag and Drop Select and drag One or more whole items to the application

Using an item in another document

Fetch lets you use the cataloged source files in other publications or
presentations. For example, you might include a SuperPaint illustration
in a PageMaker publication or import a QuickTime movie into a
Persuasion presentation. Fetch lets you copy any such source file (or
part of it) to the Clipboard and then, in the receiving application, paste
it in the document you want.

You can drag files from the Gallery or Pasteboard windows into the
receiving application, if the application is drag-capable. Extensis
provides drag and drop plug-ins for some applications that would not
otherwise have this capability (for example, QuarkXPress). See the
ReadMe file for specific information on drag-capable applications.

For an increasing number of applications that are Fetch-aware, Fetch can
copy or send a reference only, so that the receiving document receives a
reference, or pointer, to the original file rather than the entire file.

Fetch-awareness can vary from supporting a special Clipboard format
for copying and pasting a reference to supporting the “Place Apple
Event.”  For information on how to use the different transfer methods,
see the procedures described below. For details regarding how your
application supports Fetch, refer to Chapter 4: Using Fetch with Other
Products, or contact the application’s manufacturer.
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Placing an item in another application

Note: Your application must support Fetch Drag and Drop to use this
feature. If Fetch supplies a Drag and Drop plug-in for the application,
the plug-in must be installed in the application.

To drag-place an item:

1. In Fetch, select an item (or several items) in either the Gallery
or Pasteboard.

2. Drag and drop the item(s) into an open document in the receiv-
ing application.

If the receiving application can accept the item’s file type, the item
will be “placed” in the application.



29

Transferring a file

Copying an item from Fetch and pasting it in your page layout or other
application uses the Macintosh Clipboard and copies the entire source
file (or selected part thereof) into the receiving application. You can use
this method to transfer any catalog item to any appropriate application,
whether it is Fetch-aware or not. The receiving document increases in
size by the size of the original file or of the selected portion of the file.

You can always copy all or part of an item. Its format, however, may
change when placed in the Clipboard. The format change depends on
the item’s original file type:

• Copying a still image (such as EPSF, TIFF, DCS) to the Clipboard
changes it to a PICT format. Of particular note are EPSF images. If
you copy an entire EPSF image, Fetch places PostScript information
in the resulting PICT. If you copy only part of the EPSF image, the
resulting PICT will lack the PostScript information and not print
correctly.

If you need to preserve the image’s original format, you must
manually import the image into the application.

• Copying a movie, in all or in part, copies only the movie reference,
not the actual frames.

• Copying a sound changes it to the SND format.

To transfer an item or part of an item using “Copy”:

1. In Fetch, select an item. Or open a Preview window that
contains an item and select the part of the item you want.

2. Choose “Copy” from the Edit menu.

3. In the receiving application, choose “Paste” from the Edit menu.

Transferring a reference

Copying or sending a reference is preferable to copying and pasting a
file because the receiving document has the option of storing only the
reference rather than the entire file. Storing only a reference minimizes
the size increase of the receiving document.

How you place an item in the receiving document depends upon the
application you are using. Some Fetch-aware applications require you
to paste the reference into the document; others provide a palette or
other mechanism for selecting and placing the item. For details, refer to
the documentation provided by the application’s manufacturer.
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To transfer one or more items using “Copy Reference”:

1. In Fetch, select one or more items.

2. Choose “Copy Reference” from the Edit menu, then choose
“Include Text” or “Include Thumbnails” from the submenu.

Include the text when the receiving application does not accept
thumbnails. Include the thumbnail when the receiving application
does accept text.

3. In the receiving application, place the item according to proce-
dures described in the application’s own documentation.

Note: You can copy no more than 125 items at a time. If you have more
than 125 items selected when you choose “Copy Reference,” Fetch
displays a message asking you to select fewer items and to retry the
Copy command.

To transfer one or more items using “Send Reference…”:

1. In Fetch, select one or more items.

2. Choose “Send Reference…” from the Item menu.

3. In the dialog box, identify and locate the receiving application.

The application can be on your own computer or on another
Macintosh on the network.

4. In the receiving application, place the item according to proce-
dures described in the application’s own documentation.



31

When you want to know more about an individual item than
Extensis Fetch displays in either Thumbnail or Text List view,
select the item and open an Info window. You can have as many
Info windows open as memory allows. A separate Catalog Info
window provides additional detail about the catalog as a whole.

The Catalog Info window provides
detailed information about the number
of items in the catalog, the size of the
catalog, modification dates, all
keywords used, and all volumes on
which any catalog items reside.

A Displays catalog name.

B Displays information about the
catalog’s filename, size, and
location.

C Displays information about the cat-
alog, including the name of the per-
son who last set the password if any.

D Displays the master keyword list and
lists the number of files containing
each keyword.

E Displays a list of all volumes
referenced by the catalog, with
unmounted volumes in italics.

The Catalog Info window

Working in the Catalog Info window

Viewing item or catalog information

C

B

A
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To do this… Follow this procedure…

Open the Catalog Info window Choose “Catalog Info…” from the File menu. Or double-click the left end of the
information bar in the Gallery or Pasteboard window.

Retrieve all items with this keyword Double-click that keyword in the “Keywords” list box.

Refresh the keyword list Double-click the word “Keywords.”

Refresh the volume list Double-click the word “Volumes.”

Toggle the keyword list order Press Option + click “Keywords” to toggle the order between alphabetical and
frequency-of-use.
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An Info window displays detailed informa-
tion about an item, including its filename,
type, size, creation and modification
dates, pathname, keywords, and descrip-
tion. Fetch lists open Info windows on the
Window menu.

A Displays the item’s filename.

B Displays information about the item’s
source file. Size, creator, and cre-
ation and modification dates are
taken from information in the source
file. If the information is italicized, the
information came from the last time
Fetch looked at the file.

C Displays information about the item’s
entry in the Fetch catalog.

D Click here to see more information in
either of these fields.

E Displays the item’s description.

F Displays the item’s keyword list.

G Displays the item’s thumbnail.

The Info window

To do this… Follow this procedure…

Open an Info window In Thumbnail view of the Gallery or Pasteboard window, double-click the text
below the thumbnail. Or select one or more items, then choose “Get Info…”
from the Item menu (Command + I). In Text List view, double-click an item in
the list. Or select one or more items, then choose “Get Info….” In a Preview
window, double-click the center of the information bar. Or choose “Get Info…”
from the Item menu.

Edit the description Double-click the word “Description.” Or choose “Description…” from the Edit
menu (Command + U).

Edit the keyword list Double-click the word “Keywords.” Or choose “Keywords…” from the Edit
menu (Command + Y).

Retrieve all items with this keyword Double-click that keyword in the list.

Toggle the keyword list order Press Option + click “Keywords” to toggle the order temporarily between
alphabetical and frequency-of-use. To change the default order, use the
“Preferences…” command on the Edit menu.

Preview the item Double-click the thumbnail. Or choose “Preview” from the Item menu
(Command + J). For faster scrolling and zooming of still images with G-World,
hold down the G key while previewing.

Edit the source file Press Option + double-click thumbnail. Or choose “Edit Original” from the Item
menu (Command + G). To edit the source file using an application other than
the one that Fetch last associated with the item’s file type and creator, press
Option + Command + G.

Working in the Info window

C

B
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Tip

Two other helpful options
include setting a default catalog
or project and customizing the
default search.

To set a default catalog or
project, use the “Default
Document…” command on the
File menu or the “Save as
Default Document” check box in
the “Open,” “Open Project,”
“New,” and “Save As Project”
dialog boxes. The default
catalog is the one that Fetch
opens automatically when you
double-click the Fetch applica-
tion icon or to which it adds new
items when you select and drag
one or more document icons
over the Fetch icon when Fetch
is not running

To edit the default search,  use
the “Define…” command on the
Search menu. The default
search is the one that is carried
out automatically the first time
that you open a catalog after
starting the program or when
you choose “Default” (Command
+ D) from the Search menu. For
information about using the
“Define…” command, see
“Streamlining your searches.”

Setting preferences

The rest of Chapter 2 describes a number of features that let you
customize Fetch to suit your working style and help you work more
productively:

• Set workstation preferences using the “Preferences…” command
from the Edit menu.

• Share preferences with other users.

• Use the Pasteboard window as a temporary staging area for items
found from multiple searches.

• Create a project file that contains a set of items to which you want
quick access or that you want to send to another Fetch user.

• Use the “Print…” command to print thumbnails or full-size images
from within Fetch, or to send thumbnails or images via fax modem
to another user.

To set or change preferences:

1. Choose “Preferences…” from the Edit menu.

Note: If the Fetch Preferences file has been locked using the
Finder’s “Get Info” dialog box, Fetch will display a message
stating this before displaying the “Preferences” dialog box. You can
make changes in the “Preferences” dialog box when the Fetch
Preferences file is locked, but Fetch will not save those changes
when you quit the program.

2. Choose the options you want, then click “OK.”
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Setting preferences in Extensis Fetch

Option Choices Description

Default Window Find… Makes Find window active when you open a catalog; displays the
default search in the Find window.

Gallery (Text List) Makes Gallery window active when you open a catalog; performs a
“Find All” search; displays result of search in Gallery window in Text
List view.

Gallery (Thumbnail) Makes Gallery window active when you open a catalog; performs a
“Find All” search; displays result of search in Gallery window in
Thumbnail view.

On Startup None Double-clicking the application icon starts the program.
Open Document Double-clicking the application icon starts the program, then opens

the file directory dialog box where you can choose a catalog or
project to open. To start Fetch using this option at any time, press
Option + double-click the application icon.

Default Document Double-clicking the application icon starts the program and opens
the catalog or project identified as the default.

Sort Keywords By Name Sorts item keyword lists alphabetically.
By Occurrences Sorts item keyword lists by frequency-of-use. To toggle the order

temporarily, press Option + click “Keywords” below the keyword list
box.

Preview Window Full Size Displays previews at full size (100% magnification).
Scaled to Fit Displays previews at a magnification that Fetch chooses based on

the size of your monitor.

Dimensions Sets the default measurement system for displaying dimensions
(inches, points, picas, centimeters, or millimeters).

Skip Add/Update Dialog When checked, does not display the “Add/Update Options” dialog
box when you choose “Add/Update Items…” from the Admin menu.
Press Option + choose “Add/Update Options…” to toggle the default
temporarily.

Auto Update When checked, automatically updates the location of a file when
you move it.

Dither Previews When checked, attempts to improve the display of color and
grayscale images when viewed at a lower bit depth than the original
image (for example, on a monochrome monitor). Using this option
requires more memory and may result in slower drawing of
previewed images. To turn on dithering, hold down Shift key while
previewing; to turn off, hold down Command key while previewing.
Requires Color QuickDraw.

Play Movies/Sounds at Preview When checked, movie and sound items play automatically when
previewed.

Show Badge in Movie When checked, movies appear in Preview windows with a badge
rather than a control bar. Click the badge or press Tab to display the
control bar when you want it.
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Shortcuts

Open Pasteboard window
(“Pasteboard” on Window menu)
Command + B

Copy selected item to
Pasteboard window
(“Copy To Pasteboard” on Item
menu)
Command + M or
Press Control + click thumbnail

Clear selected item from
Pasteboard window
(“Clear” on Edit menu)
Clear

Using the Pasteboard window

The Pasteboard window is a place where you can temporarily store
items while a catalog is open. For example, you might select items
displayed in the Gallery window as the result of a series of searches,
copy them to the Pasteboard window, and then do any of the following:

• Select items in the Pasteboard window, then choose “Preview” from
the Item menu to compare the items and pick the one you really
want. For information about previewing, see “Previewing an item.”

• Select items, choose “Export…” from the Admin menu to export the
items, and then import them into a new or another catalog. For more
information, see “Maintaining a catalog.”

• Select items, then copy and paste them into another document or
copy or send references to the items as described in “Using an item
in another document.”

• Choose “Print…” from the File menu to print the set of thumbnails.
For more information, see “Printing catalog items.”

The Pasteboard window functions like the Clipboard but is able to hold
more than one item at a time. Fetch clears the Pasteboard window when
you close the catalog. You can display the Pasteboard window, like the
Gallery window, in Thumbnail view or Text List view. All of the procedures
and shortcuts (except for searching) used in the Gallery window also work
in the Pasteboard window. For details, see “Viewing search results.”

To copy an item to the Pasteboard:

Select one or more items in the Gallery window, then choose
“Copy To Pasteboard” from the Item menu.    —or—

Press Control + click the item’s thumbnail in the Gallery
window, Info window, or List view.     —or—

Drag items from the Gallery to the Pasteboard.

By selecting and copying items one at a time, you can ensure that
the items appear in the Pasteboard window in exactly the order you
want.If you select multiple items to copy, they will appear in the
Pasteboard in the order they appear in the Gallery window.

To see the contents of the Pasteboard window:

Choose “Pasteboard” from the Window menu, or press Com-
mand + B.

To clear an item from the Pasteboard window:

Select the item, then choose “Clear” from the Edit menu.

The Pasteboard window in Thumbnail
view

The Pasteboard window in Text List
view
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Creating a “project” in Extensis Fetch

An Extensis Fetch project is a collection of references to items from a
single catalog that you save as a separate file. Use a project for work
in progress or to give or send items to another user. Because a project
file includes only references or pointers to items in the original
catalog, it is small in size and can easily be mailed to a user
electronically or copied to a floppy disk.

Consider these scenarios and imagine how project files could help you:

• An editor uses a project file to send images to a designer or produc-
tion artist for the final layout of an article.

• At a newspaper, a photo editor regularly catalogs newly scanned
photos, then circulates a daily or weekly project file that contains
only the most recent photos for editors to review.

• A production artist who is completing a monthly newsletter creates
a project file that contains all the necessary artwork. Without having
to search for all the images in a catalog, the artist merely opens the
newsletter project.

To create a project:

1. In either the Gallery or Pasteboard window, select the items
you want.

2. Choose “Save As Project…” from the Item menu.

3. In the file directory dialog box, enter a name, then click “OK.”

To open and use a project:

Regardless of whether Fetch is currently running, you can either:

• Double-click the project icon in the Finder.

• Or drag the project icon over the Fetch application icon.

If Fetch is running and:

• A catalog is open, choose “Open Project…” from the File menu,
then select the project.

• No catalog is open, choose “Open…” from the File menu, then
select the project.

Fetch must be able to locate the catalog when you or another user opens
a project created from it. When you open the project, Fetch opens the
catalog from which the project items were saved, then opens the
Pasteboard window and copies the project items to it. If the catalog was
already open, Fetch adds the project items to any items already in the
Pasteboard window.

Extensis Fetch project icon
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Print Option              Choices Description

Print Using… Actual Images Prints thumbnails using the original source files if available. This
option generally yields a higher-quality output, but can be time
consuming because Fetch must open and process each item’s
source file when creating its thumbnail. Thumbnails in the cata-
log are substituted for any actual images that are not found. Fetch
will not look for images from files that have been moved.

Thumbnails in Catalog Always prints from the thumbnail images available in the catalog.

Quality Best (slowest) Provides the highest-quality output and the slowest print times.
Better Provides medium-quality output at moderate print times.
Good (faster) Provides the lowest-quality output but the fastest print times.

Larger Thumbnails When checked, prints thumbnails that are twice the normal
height and width (four times the area of a regular thumbnail).

Number pages from Unless you enter a number for the first page of your output, Fetch
starts with page 1 or with the number specified at the beginning of
the dialog box.

To make projects even easier to use, you can create an alias for a
frequently used project, and place that alias in your Apple Menu Items
folder (in your System folder). Your project will then appear in the
Apple Menu. Selecting the project from the menu will launch Fetch (if
it’s not running already) and open the project.

Printing catalog items

Although you will typically find and select a catalog item either to edit
the source file or use it in another document, you might want to print
from the catalog itself—to show to a client, for example, or to evaluate
items for possible use in a document.

When you choose “Print…” from the File menu, Fetch prints the contents
of the active window. Thus, to print thumbnails, print from the Gallery or
Pasteboard window. To print a single full-size image, print from a Preview
window. If you have a fax modem installed in your computer, you can
also use the “Print…” command to fax thumbnails or images to another
person. Use the Chooser to specify the output device that you want.

When you choose the “Print…” command, the resulting dialog box
reflects what you have in the active window:

• If the active window is a Preview window, what you see is the
standard Macintosh “Print” dialog box that contains no special
options for Fetch.

• If the active window is the Gallery or Pasteboard window the print
dialog box will show the options described in the table below. Note:
Options may vary with different printer drivers.

Options for printing thumbnails
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Troubleshooting printing problems

Make sure that you are using LaserWriter driver 8.0 or later. To find out
which version you are using, select the LaserWriter file in the Exten-
sions folder of the System folder and choose “Get Info” from the File
menu.

If using the “Actual Images” option causes problems, it may be that
your printer is having trouble handling the amount of information
needed to print the page. Try making these adjustments to correct the
problem:

• Print using the “Black & White” option in the “Print” dialog box.
This allows the printer to print all colored areas as black or white,
depending on the darkness of the area. This option usually decreases
the quality of the printed image, but may require less printer
memory.

• Print using the “Larger Thumbnails” option. This reduces the
number of thumbnails per page.

• Print using the “Better” or “Good” option. This helps limit the
amount of information needed to print each thumbnail.

• Turn background printing off in the Chooser. This frees the printing
process from having to compete with other applications for memory.

• Allocate more memory to the PrintMonitor or install more RAM
in the printer. This increases the amount of memory available for
printing.

• Allocate more memory to Fetch. This lets Fetch use more memory
to prepare the image for printing.

If you do not get the results you want when printing from the Preview
window using the “Black & White” option, try printing using the
“Color/Grayscale” option instead. This results in the printer using black
dots to approximate the darkness of colored or gray areas in the image.
While the “Color/Grayscale” option may increase the quality of your
printed image, it may require more printer memory.

Most color images will print in color when sent to a color printer.
However, color images that require QuickTime to preview will not
print in color when your monitor is set to grayscale. To print these
images in color, use the Monitors control panel to reset your monitor to
color before printing the image.
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3—Creating and Managing Catalogs

Chapter 3 describes how to create, maintain, and modify Extensis Fetch
catalogs; how to add and modify keyword lists and item descriptions;
and how to control access to administrative functions in a network
environment.

To carry out most of the procedures described in this chapter, you must
have full access to the open catalog.

A Start Fetch, choose “New…”
from the File menu as
described below, and then
choose “Add/Update Items…”
from the Admin menu as
described in “Updating and
adding items to a catalog.”

B If no catalog is open and you do
not have a default catalog,
select the items you want the
catalog to contain, drag the
icons onto the Fetch application
icon until all icons are
highlighted, and then release.
You will be informed that no
catalog is open and be given
the option to create one.

Creating a new catalog from within Extensis Fetch

When you create a catalog using the “New…” command, Fetch
prompts for a catalog name, then opens the catalog and displays your
default startup window. The catalog is empty. To add items, follow the
instructions in “Updating and adding items to a catalog.” Or import a
previously exported catalog (or part of a catalog) as described in
“Maintaining a catalog.”

Creating a new catalog

You can create a new catalog in either of these two ways:
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To create a new catalog:

1. Start Fetch, then choose “New…” from the File menu.

If you already have a catalog open, the “New…” command is
dimmed. You must close the open catalog before you choose
“New…” because Fetch allows only one catalog to be open at a
time.

2. In the file directory dialog box, specify a name and location for
the new catalog.

3. Check “Save as Default Document” if you want the new catalog
to be your default catalog.

The default catalog opens automatically on startup if you have it set
to do so in the Fetch preferences. Files are also added to the default
catalog when you drag icons over the Fetch icon when Fetch is not
running.

4. Click “Save.”

Fetch creates the catalog, opens it, and then opens the Find window.

5. Add items to the catalog as described in “Updating and adding
items to a catalog.”

Creating a new catalog from the Finder

When you create a new catalog by dragging items over the Fetch icon,
the selection can include files, folders, or entire volumes in any
combination. If no other catalog is open and you have not established a
default catalog, Fetch asks you to create a new catalog. Otherwise, the
files you drag over the Fetch icon are added to the default catalog (if
there is one) or to the open catalog.

To create a new catalog from the Finder:

1. Start Fetch, then close any open catalogs.

2. In the Finder, select the icons for the files, folders, or volumes
that you want in the catalog.

3. Drag the collection of icons over the Fetch icon; the Fetch icon is
highlighted. If the Fetch icon does not become highlighted, you
may need to rebuild your desktop. To do so, press and hold
down Option + Command while restarting your computer.

After you release the collection of icons, Fetch starts up and asks if
you want to create a new catalog or open an existing one.

Shortcuts

Create a new catalog
(“New…” on File Menu)
Command + N

Save new catalog as default
(“Save as Default Document”
option in file directory dialog box)
Command + S

Add items to a catalog
(“Add/Update Items…” on
Admin menu)
Command + E
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4. Click “New.”

5. In the file directory dialog box, specify a name and location for
the new catalog. Check “Save as Default Document” if you want
the new catalog to be your default catalog, then click “Save.”

The default catalog opens automatically on startup if you have it set
to do so in the Fetch preferences. Files are also added to the default
catalog when you drag icons over the Fetch icon when Fetch is not
running.

6. Review the settings in the “Add/Update Options” dialog box,
change any that you want, and then click “Continue….”

For more information on the options in this dialog box, see “Setting
catalog update options.”

Updating and adding items to a catalog

To ensure that a catalog contains the most recent versions of your files,
you should update the catalog after you’ve made changes to your files
or after you’ve moved or deleted files.

To add items to a catalog when the catalog is open to either the Gallery
(thumbnails or list view) or Pasteboard, go to the Finder and select the files
you want to add, then simply drag them into the Gallery or Pasteboard
window.

To add items to the default catalog when Fetch
is not running, select the files, then drag them
onto the Fetch application icon.

To add items to any catalog, open the catalog,
return to the Finder, select the files, then drag
them onto the Fetch application icon.

You can add or update catalog items in any of these ways:

Start Fetch, open the catalog, then choose
“Add/Update Items…” from the Admin menu.
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Tips

Fetch ships with a reasonable
set of default settings for
cataloging most files under most
circumstances. You can change
these options at any time, return
to the original defaults, or create
your own. For more information
about these options, see “Setting
catalog update options.”

The “Add/Update Options” dialog
box appears only if the option
“Skip Add/Update Dialog” is
unchecked in the “Preferences”
dialog box (use the “Prefer-
ences…” command on the Edit
menu). By default, this option is
unchecked, so that you will
continue to see the “Add/Update
Options” dialog box each time
until you reset your preferences.

Updating from within Extensis Fetch

When you add to or update a catalog using the “Add/Update Items…”
menu command or by dragging files from the Finder, Fetch always
displays the “Add/Update Options” dialog box allowing you to change
options before continuing. When using the “Add/Update Items...” menu
command, a file directory dialog box appears, allowing you to locate
and select the files, folders, or volume that you want to add to the open
catalog. After the files have been selected, Fetch begins adding/
updating and presents progress screens so you can track its progress.

To add or update catalog items:

1. Start Fetch and open a catalog. Next, choose “Add/Update
Items…” from the Admin menu, or select files directly in the
Finder and drag them into the catalog Gallery or Pasteboard
window.

2. Review the settings in the “Add/Update Options” dialog box,
change any that you want, and then click “Continue….”

3. If you selected the “Add/Update Items” from the menu, a file
directory dialog box will appear. Locate the file, folder, or
volume that you want to add to the catalog. The volume that
contains the files you want to add must be mounted (currently
available) before you continue.

To add… Follow this procedure…

A single file In the Finder, select the file and drag it into the
Gallery or Pasteboard window. Or, from the list
box, select the file you want and click “Open.”

All files in a folder or in Drag the folder into the Gallery or Pasteboard
a volume window. Or, from the list box, make sure that

the name of the file or folder you want appears
above the list box. Click “Folder.”

All files and subfolders Drag the folder with subfolders into the
within a folder or volume Gallery or Pasteboard window. Or, from the list

box, make sure that the name of the folder or
volume you want appears above the list box.
Check “Include Subfolders,” then click “Folder.”

A single file whose First add the application’s file type in the
file type is not listed “Preferences: File Types” dialog box, then use

the “Add/Update” dialog box to add the file.
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If you choose to add items from an aliased folder, make sure that
the folder’s alias is no more than 27 characters long. Fetch treats
folders as if they were volumes, and volume names in System 7
have a 27 character limit. If the folder’s alias exceeds this limit,
Fetch can crash when trying to access the items within the folder.

When using the “Include Subfolders”  menu option, or when
dragging nested folders into a catalog, make sure that the
subfolders are not aliased. Fetch ignores aliased subfolders and
will not add them to the catalog. To add an aliased subfolder to a
catalog, you must select and add it directly.

Fetch quickly scans the volume where the source files reside,
displays the “Modification Status” box, and then begins to
examine each file in turn before adding it to the catalog. Where a
preview of the file is available, Fetch shows the preview next to
the status. If the option to include a 1-bit (black and white)
preview is selected in “Add/Update Options,” the 1-bit preview
will be shown to the right of the higher resolution preview.

When everything has been cataloged, Fetch displays an “Add/
Update Summary” message.

4. Click “OK.”

Fetch returns you to the “Add/Update Options” dialog box, where
you can click “Continue…” again or “Done” to return to your
catalog.

Important!

If Fetch crashes while trying to
catalog a file that you suspect
may be damaged, try opening
the file from the application that
created it (or another application
that can open that particular file
type). If the application cannot
open the file, do not try to
catalog the item in Fetch.

If you add the filename of the
damaged file to the exclusions
list (see “Excluding a file from
adding or updating”), Fetch will
always ignore the corrupt file in
the future. This will protect you
from trying to add the damaged
file to other catalogs.
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Updating by dragging to the Fetch icon

When you add or update files by dragging them over the Fetch icon, the
selection can include files, folders, or volumes in any combination:

• If you have a default catalog and Fetch is not already running, Fetch
updates the default catalog.

• If a catalog is open, Fetch updates the open catalog.

To update  by dragging files to an open catalog:

1. Select the icons for the files, folders, or volumes you want to add
or update.

If you want to add a Fetch catalog or project to a catalog, place the
catalog or project in a folder or volume and then select the icon for
that folder or volume. Do not select the actual catalog or project
icon since dragging one of these icons over the Fetch icon causes
Fetch to open the catalog or project instead of adding it.

2. Drag the selected icon or collection of icons over an open
Gallery or Pasteboard window, or drag the icon(s) over the
Fetch application icon.

3. Review the settings in the “Add/Update Options” dialog box,
change any that you want to change, and then click “Con-
tinue….”

When updating is complete, Fetch displays the “Add/Update
Summary” message.

4. Click “OK” to return to your catalog.

To update the default catalog, when no catalog is open:

1. Select the icons for the files, folders, or volumes you want to add
or update. While these items are still selected, select the catalog
that you want to add these items to.

2. Drag the selected icon or collection of icons over the Fetch
application icon.

3. Complete the update as if the catalog were already open.
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Use this illustration and the table on the
following page to explore the cataloging
options that Fetch provides. Using System 7.5
Balloon Help you can open the “Add/Update”
dialog box in Fetch, choose “Show Balloons”
from the Help menu, and use Balloon Help to
explore the different options.

A Click “Save As Default” to save the current
settings as the new default.

B Click “Default” to return to your previous
default settings. Note: Changes to File Types
are not changed when “Default” is selected.

C Click “Done” when you have finished
adding or updating all the items you want.

D Click “Continue…” to tell Fetch to start
adding or updating the items
using the current settings.

The “Add/Update Options” dialog box

Setting catalog update options

Unless you set your preferences otherwise, Extensis Fetch displays the
“Add/Update Options” dialog box whenever you:

• Choose “Add/Update Items…” from the Admin menu.

• Choose “Import…” from the Admin menu.

• Add items to an open catalog by dragging them into the Gallery or
Pasteboard from the Finder.

• Add items to a catalog by dragging files over the Fetch icon in the
Finder.

• Create a new catalog by dragging files over the Fetch icon in the
Finder when there is no default catalog.

The defaults that ship with the product work for most files under most
circumstances. You can change these options at any time, return to the
previous defaults, or create your own. If you prefer not to see this
dialog box each time, choose “Preferences…” from the Edit menu, then
check “Skip Add/Update Dialog” in the “Preferences” dialog box.

CBA D
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Catalog update options

Option Choices Description

Modification Method Add; Update; Add and Adds new items only if they do not already exist; updates items only
Update if there have been changes.
Add Unconditionally Adds new items even if they already exist.
Update Unconditionally Updates items even if there have been no changes. Use this setting

to regenerate thumbnails when an item’s newly created thumbnail is
not being displayed in the catalog.

Include Path None Filenames and pathnames are not added to the keyword list
as Keyword File name Adds the item’s file name to the keyword list

Folder and Adds the filename and each folder and subfolder where the file is
filename* located to the keyword list
Path name Adds the item’s path name but ignores the volume name
(except volume)*
Entire path name* Adds the item’s full path name, including volume name, to the

keyword list

Thumbnail Type(s)1 1-bit; 8-bit; 32-bit Stores 1-bit, 8-bit, or 32-bit thumbnails.
1 and 8-bit; 1 and Stores multiple versions of thumbnails, for optimal display on
 32-bit; 8 and 32-bit; different CPUs.  32-bit thumbnails are compressed by
1, 8, and 32-bit QuickTime.
Help… Provides assistance in selecting thumbnail types.

Compressor Criteria2 Any Chooses compression based on a  balance of speed, image
quality, and size.

Speed Chooses the fastest compressor.
Fidelity Chooses the highest-quality image.
Compression Chooses the smallest possible image.

Compressor Type2,3 Fair Quality Chooses speed over image quality.
Best Overall Chooses speed but considers image fidelity.
High Quality Chooses image quality over speed.
Other… Chooses customized level of quality.

File Types Lists all the file types that Fetch currently recognizes.
To check all, press Command + A. To uncheck all, press
Command + Delete. To check or uncheck a file type, click its name.

Extract Keywords* Looks for and extracts any keywords saved with source file.

Extract Description* Looks for and extracts any description saved with the source file.

Extract Thumbnail* Looks for and extracts any preview image saved with the source file.
(Note: If you are adding or updating QuickTime movies, we recom-
mend that you do not use this option. You will get a larger thumbnail
for the movie if you let Fetch create it rather than extract it.)

.
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Edit Keywords Tells Fetch to open the “Edit Description” dialog box as each item is
added or updated.

Edit Description Tells Fetch to open the “Edit Description” dialog box as each item
is added or updated.

Use “Exclusions” File Excludes any file whose name appears in the “Exclusions…” list.
For details, see “Excluding a file from adding or updating.”

Mount Remote Volumes* Attempts to mount any unmounted volume that is referenced by an alias.

* Not available during importing.

1Since Fetch installs and uses QuickTime, the default for “Thumbnail Type(s)” is set to “32-bit.” This setting does not
mean larger catalogs. In fact, the “32-bit” option means that the thumbnail will be compressed, which will save catalog
space, reduce network traffic, and yield a better-looking thumbnail—even if the original file is less than 32-bits.

2The “Compressor Criteria” and “Compressor Type” options refer only to the generation of 32-bit thumbnails
compressed by QuickTime. They have no effect on the decompression and previewing of the thumbnails.

3The recommended setting for “Compressor Type” is “Best Overall.” This setting offers the optimal compromise among
thumbnail file size, thumbnail decompression speed, and thumbnail image quality. If you want a better looking
thumbnail, you could set the “Compressor Type” to a higher-quality setting or JPEG compression. Using a higher
quality setting will increase the size of the catalog and, in the case of JPEG compression, will also increase the amount
of time needed to display a thumbnail view in the Gallery window.

Option Choices Description
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Excluding a file from adding or updating

As you build and modify catalogs, you can tell Extensis Fetch to skip
files of a certain type or name. For example, if you create pre-separated
DCS files for a PageMaker publication, you typically want to catalog
the composite file only, not the individual separation files. Or if you
have a CD-ROM disc that contains a number of files that are corrupted
but cannot be removed, you can skip those files during cataloging.

• If you want to skip files of a specific type, you can uncheck that file
type in the “File Types” list box in the “Add/Update Options” dialog
box, as described in “Setting catalog update options.” Or you can
remove the file type from the list altogether, using the “File
Types…” command on the Admin menu. For more information
about file types and Fetch, see “Adding a file type.”

• If you want to skip files with a specific name, you can use the
procedures described on this and the following pages to create an
exclusions list.

You can create an exclusions list by selecting items within an existing
catalog or by giving Fetch an explicit set of names.

• When you have a catalog open, you use the “Add To Exclusions”
command on the Admin menu to add selected items to the exclu-
sions list. “Add To Exclusions” is dimmed if there are no items
selected in the Gallery or Pasteboard window or if no Preview or
Info windows are open.

• Whether you have a catalog open or not, you can use the “Exclu-
sions…” command on the Admin menu to specify files by name.

In either case, Fetch creates for all catalogs a single exclusions list
(Extensis Fetch™ Exclusions) in the Extensis Fetch™ Preferences
folder in the Preferences folder of the System folder. You can share this
list with other users by copying it.

To add cataloged items to the exclusions list:

1. In the Gallery or Pasteboard window, select the items whose
filenames you want Fetch to skip when adding or updating
catalogs in the future.

2. Choose “Add To Exclusions” from the Admin menu.

Fetch exclusions icon
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To view or modify the exclusions list:

1. Choose “Exclusions…” from the Admin menu.

2. In the “Exclusions” dialog box:

To… Follow this procedure…

Add a name Type the filename you want into the edit box,
then click “Add.”
Pathnames are not allowed.
Case is ignored.
Names can include an asterisk (*) as a wildcard
character. For example, to tell Fetch to skip the
individual separation files when updating a DCS
file, you can add “*.c,” “*.y,” “*.m,” and “*.k” to
the exclusions list.

Rename an entry Select it in the list box, type a new name in the
edit box, then click “Replace.”

Remove a name Select it in the list box, then click “Delete.”

3. When you have made all the changes you want, click “Done”
to close the dialog box and save the list.

Shortcuts

Delete a filename
(“Delete” button in
“Exclusions” dialog box)
Command + D

Replace a filename
(“Replace” button in
“Exclusions” dialog box)
Command + R

Close dialog box
(“Done” button in
“Exclusions” dialog box)
Command + Return
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Adding a file type

Extensis Fetch can recognize and catalog many types of files,
including those created by the most widely used desktop publish-
ing programs, presentation programs, and other programs for
creating graphics, movies, sounds, and animations. For a complete
list of the file types that Fetch recognizes, refer to the table at the
end of this section (pages 52–53).

Using the “File Types…” button in the “Preferences” dialog box,
you can modify the list by adding, replacing, or deleting file types,
as long as the list contains no more than 64 file types at a time. For
example, you might want to add the file type for an application that
you use frequently, but whose file type is not currently on the list.
Or you might replace an existing file type when the manufacturer
ships a new version of the product. You could even remove
altogether file types that you do not want to catalog and whose
name you do not want to appear in the list in the Find window or in
the “Add/Update Options” dialog box.

If you add the file type for an application that does not save a
preview, what you see in Fetch is a file icon, not a thumbnail.
Although you cannot preview these files in Fetch, you can enjoy
the other benefits of having the file cataloged and accessible from
within the catalog. In addition, if the file’s creator application
exists on your computer, you can open and view the file by
choosing “Edit Original...” from the Item menu.
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To modify the list of file types that Fetch recognizes:

1. Choose “Preferences” from the Edit menu.

2. Click on “File Types….” in the “Preferences” dialog box.

In the “File Types” dialog box:

To… Follow this procedure…

Add a file type In the “Name” edit box, type a description up to 31
characters long. In the “Type” edit box, enter the
four-letter code for the file type you want to add.

Choose “Catalog” under the “Store in:” option if
you want the file type to be added to the list stored
with the Catalog file (a catalog-specific list).

Choose “Preferences” under the “Store in:” option
if you want the file type to be added to the list
stored in the Preferences file (a user-defined
default list). Then click “Add.”

Replace a file type Select it in the list box, type a new name in the
edit box, then click “Replace.”

Remove a file type Select it in the list box, then click “Delete.”

Add the original Select “Add Originals” to add the default list to
default list to any existing list.
existing list

3. Click “Done” to close the dialog box and save the revised list.

Tip

To add a file type if you are
not sure what name or code
to enter:  click “Same type
as…”. In the resulting file
directory dialog box, select an
example of the type of file that
you want to add, then click
“Open” to return to the “File
Types” dialog box. Then click
“Add.” OR double-click on one
of the file types in the list to
automatically enter the infor-
mation into the “Name” and
“Type” edit boxes. Then click
Add.”
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File formats

File type Name    Preview? Thumbnail or icon

ULAW .au Sound Files Yes I

WAVE .wav Sound Files Yes I

PDF Acrobat PDF Yes T

APPL Application No I

AIFF Audio Interchange Yes I

AIFC Audio Interchange (Compressed) Yes I

BMPp Bitmap No I

CWGR ClarisWorks Drawing v3–v4 Yes1 T2

CWPT ClarisWorks Painting v3–v4 Yes1 T2

drw5 Deneba Canvas v5 No1 T2

edtp Edition (PICT) Yes T

edtt Edition (TEXT) Yes T

EPSF EPSF Yes1 T2

sfil Finder Sound Yes I

GIFf GIF Yes T

JPEG JPEG Yes T

JFIF JPEG Interchange Format Yes T

FtCF Extensis Fetch Catalog v1.2–v1.5 No I

FtPJ Extensis Fetch Project v1.2–v1.5 No I

AGD2 Macromedia FreeHand v7 Yes1 T2

AGD1 Macromedia FreeHand v4–v5.5 Yes1 T2

sGD1 Macromedia FreeHand Template v4–v5.5 Yes1 T2

FHD3 Macromedia FreeHand v3.x No I

FHT3 Macromedia FreeHand Template v3.x No I

AB65 Adobe PageMaker v6.5 No T2

AT65 Adobe PageMaker v6.5 Template No T2

ALB6 Adobe PageMaker v6 No T2

ALT6 Adobe PageMaker v6 Template No T2

The following table lists all of the file types recognized by Fetch at
the time this book went to press. For each file type, the table shows
the application typically used to create it and other applications in
which you can edit it.

.
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ALB5 Adobe PageMaker v5 No T2

ALT5 Adobe PageMaker v5 Template No T2

ALB4 Adobe PageMaker v4 No T2

ALT4 Adobe PageMaker v4 Template No T2

PRS3 Adobe Persuasion v3 Yes T

PRT3 Adobe Persuasion Template v3 Yes T

PPFf Adobe Persuasion Player v3 Yes T

8BPS Adobe PhotoShop v2.5–v4 Yes T

8BIM Adobe PhotoShop v2.0 Yes1 T2

PCDI KODAK Photo CD Yes T

PNTG MacPaint Yes T

MIDI MIDI Sound File Yes I

MuAd Multi-Ad Creator Yes1 T2

AdSt Multi-Ad Creator Stationery Yes1 T2

PICS PICS Animation Yes T

PICT PICT Yes T

XDOC QuarkXPress Document No T2

3DMF QuickDraw 3D Yes T

MooV QuickTime Movie Yes T

MooV QuickTime VR Yes T

RIFF Resource Interchange No I

..CT SciTex CT Yes1 T2

FSSD SoundEdit Yes I

TPIC TARGA Yes T

TEXT Text Yes I

TIFF TIFF Yes T

???? Unknown  Yes1 T2

File type Name    Preview?     Thumbnail or icon

1Extensis Fetch will display a preview of this file if it has been generated by the parent application.
2Extensis Fetch will display a thumbnail of this file if it has been generated by the parent application.
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Organizing a catalog by adding keywords

Each item in a catalog has certain information associated with it, such
as filename, file type, volume, and so on. Each item can also have one
or more keywords associated with it. A keyword is a word or phrase
that you associate with a particular item, allowing you to search for
items quickly.

Like a library with a good subject catalog, a Fetch catalog with a good
keyword list can be a valuable tool for finding the information you
need. In addition, keywords created by other applications can be
extracted during cataloging if they’re available in the source file or
added and edited later. Each item can have an unlimited list of key-
words associated with it (each up to 31 characters long). In a network
environment, a catalog administrator can control who edits keyword
lists for each catalog (see “Setting catalog privileges” on page 64).

To extract keywords from source files when adding the files
to a catalog:

Make sure that “Extract Keywords” is checked in the “Add/Update
Options” dialog box, then continue to add or update items.

Fetch then examines each source file for keywords that were
previously created with the source file’s application. As Fetch
catalogs the item, the extracted keywords are added to Fetch’s
keyword list for that item. An extracted keyword appears in italics
in the “Keywords” list box in Text List view or in the Info window
and cannot be further edited from within Fetch. Unless the option
“None” is selected in the pathname option pop-down of the Add/
Update dialog, Fetch automatically adds the filename and the folder
name of the item as keywords.

To enter keywords manually while adding items to a catalog:

1. Make sure that “Edit Keywords” is checked in the “Add/Update
Options” dialog box, then continue to add or update items.

Fetch displays the “Edit Keywords” dialog box as it examines each
item before adding it to the catalog.

2. Enter one or more keywords, then click “OK” to return to the
“Modification Status” box and continue with the next item.

Shortcuts

Open Info window
to see item’s keyword list
(“Get Info” on Item menu)
Command + I  or
Double-click the filename of the
item in the list view

Open Catalog Info window
to see master keyword list
(“Catalog Info” on File menu)
Double-click left end of
information bar in Gallery or
Pasteboard window

Edit keyword list
(“Keywords” on Edit menu)
Command + Y  or
Double-click “Keywords” in
item’s Info window
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To display the existing keyword list for an item:

Select the item, then choose “Get Info…” from the Item menu.

A  above the list indicates that you do not have permission to
edit the list.

or

Select the item from the Text List view of the Gallery or Paste-
board window.

To edit the keyword list for a single item:

1. Select the item, then choose “Edit Keywords…” from the Edit
menu.

Or display the keyword list as described above, then double-click
the word “Keywords”  below the list box.

Note: If  any of the“Keywords…” items on the Edit menu are
dimmed, you do not have permission to edit keywords in the open
catalog. If you’re using Fetch in a network environment, check with
your catalog administrator.

The list box on the right contains any
keywords added during or after
cataloging. These appear in normal type
in all keyword lists and can be edited by
those with permission to do so.

The list box on the left contains any
keywords extracted from the item’s
source file. These appear in italics in
the combined keyword list and cannot
be edited within Fetch.
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Indicates the number of items
selected to have the new
keyword(s) added.

2. In the edit box:

To… Do this…

Add a new keyword Type the word, then click “Add” (or press
Return).

Remove a keyword Select it, then click “Delete” (or press
Command + D)

Change a keyword Select it, type the new wording, and then click
“Replace” (or press Command + R).

Note: Fetch automatically removes a keyword from the master
keyword list if there is no item associated with the keyword. There-
fore, when you delete or purge an item from the catalog, any
keywords associated with the item are deleted from the master list if
there are no other items that contain those keywords.

3. Click “Apply” (or press Command + Return) to save the
changes and close the dialog box.

To add the same keywords to multiple items at once:

1. Select the items you want, then choose “Assign Keywords…”
from the Edit menu.

2. In the “Assign Keywords” dialog box, enter the keywords you
want as described above.

3. Click “Apply” to save the changes and close the dialog box.

Note: “Add,” “Delete,” and “Replace” refer to keywords in the
keyword list box under “Keywords to be Assigned.” To apply a single
keyword to multiple items, enter the keyword and click “Apply.”
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To remove the same keywords from multiple items at once:

1. Select the items you want, then choose “Remove Keywords…”
from the Edit menu.

2. In the “Remove Keywords” dialog box, enter the keywords you
want as described earlier.

Tip

To “batch delete” keywords, use
the “Remove Keywords” item
on the Edit menu after selecting
the Fetch items you wish to
change. You can change a
single keyword across multiple
items, or create a list of
keywords for deletion.

Note: If you accidentally delete
the  wrong keyword from
multiple items, you can easily
replace it using the “Assign
Keywords” menu item.

3. Click “Apply” to save the changes and close the dialog box.

To print the master keyword list:

1. Choose “Export…” from the Admin menu when the Catalog
Info window is active.

2. In the “Save As” dialog box, enter a name, then click “OK.”

3. Open the file in a word-processing program and print the list
from there.

Note: You cannot make changes to the keyword list in a word-
processing program and then import the list back into Fetch; you
can only make changes within Fetch.

Note: “Add,” “Delete,” and “Replace” refer to keywords in the
keyword list box under “Keywords to be Removed.” To remove a
single keyword from multiple items, enter the keyword and click
“Apply.”

Indicates the number of items
selected to have the same
keyword(s) removed.
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Shortcuts

Open Info window
to see item description
(“Get Info” on Item menu)
Command + I or
Double-click the item’s filename

Edit description
(“Description” on Edit menu)
Command + U  or
Double-click “Description”

.

Adding descriptions

In addition to adding keywords to any item, you can add a description
up to 32,000 characters long. You can use the description field to keep
track of any information about the source file that you might find useful
or important. For example, you might use a description to keep notes
about the origin of an item or how it should be used. The description
for a photoimage could include notes about who took the original
photograph, where the original is stored, who scanned the image, the
scanner settings, copyright, and agency or contact information.

If the original application provides a way for you to enter and save
descriptive text with the source file, you can often have Fetch extract
this information automatically as it catalogs the item. Otherwise, you
can add or edit a description either during or after cataloging. It is
recommended that you create descriptions in your favorite word-
processing program, then paste them into the description field. In a
network environment, a catalog administrator can control who edits
descriptions. For more information on catalog administration, see
“Setting catalog privileges.”

To extract descriptions while adding items to a catalog:

1. Make sure that “Extract Description” is checked in the “Add/
Update Options” dialog box, then continue to add or update
items as described earlier in this chapter.

Fetch then examines each source file it catalogs for a description
and adds it to the catalog entry for the item. An extracted descrip-
tion appears in italics in the “Descriptions” field in Text List view or
in the Info window and cannot be further edited from within Fetch.

To enter descriptions manually while adding items to a
catalog:

1. Make sure that “Edit Description” is checked in the “Add/
Update Options” dialog box, then continue to add or update
items as described in “Updating and adding items to a catalog.”

Fetch then displays the “Edit Description” dialog box as it scans
each item to add to the catalog.

2. Type or paste a description, then click “OK” to return to the
“Modification Status” box.
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To display the description for an item:

Select the item, then choose “Get Info…” from the Item menu.

or

Select the item in Text List view of the Gallery or Pasteboard
window.

To edit the description for an item:

1. Select the item, then choose “Description…” from the Edit
menu. Or display the description as described above, then
double-click the word “Description” below the list box.

Note: If “Description…” is dimmed on the Edit menu, you do not
have permission to edit descriptions for items in the open catalog. If
you are working in a network environment, check with your catalog
administrator.

The list box on the right contains the
description added during or after
cataloging. This appears in normal
type in the combined description
field and can be edited by those with
permission to do so.

2. In the box on the right, type or paste new text.

3. Click “Done” (or press Command + Return) to save the descrip-
tion and close the dialog box.

Tip

To enter the same description
for a number of different items,
you can use the Clipboard. For
example, if you scan a number
of images using the same
scanner settings, you can enter
the description of the settings in
the description field for one of
the items, then use “Select All”
and “Copy” to copy the
description to the Clipboard.
From the Clipboard, you can
paste the same description into
the description field for each of
the remaining items.

The list box on the left contains the
description, if any, extracted from the
item’s source file. This appears in
italics in the combined description field
and cannot be edited within Fetch.
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Maintaining a catalog

Catalogs—especially large ones—that are heavily used and frequently
updated can become out-of-date. In addition to routinely backing up all
catalogs and source files (and keeping the backups in a safe place), it is
a good idea to perform other housecleaning tasks regularly as well.

The Admin menu provides the catalog manager or administrator with
tools that can help with everything from routine catalog maintenance to
attempting to recover a catalog if something does go wrong.

Merging catalog contents

The “Export…” and “Import…” commands let you merge complete or
partial contents of catalogs, create new ones from old ones, or recatalog
the recovered contents of a damaged catalog. Exporting and importing
are also useful ways to back up a catalog, to compact a catalog from
which you regularly delete numbers of items, and to keep a catalog in
good repair.

When you export and import catalogs, Fetch keeps track of thumbnails,
keywords, and descriptions so that you do not lose valuable catalog
information.

To export a catalog:

1. Open the source catalog and use the Find window to retrieve
and select the items you want to add to the destination catalog.

Use “Find All” and “Select All” if you want to export the entire
catalog. Or copy selected items to the Pasteboard window (in the
order in which you want them in the new catalog), then select all the
items in the Pasteboard window.

2. Choose “Export…” from the Admin menu.

3. In the file directory dialog box, enter a name for the export file,
then click “Save.”

Important!

If you create a project in a
catalog and then delete items
prior to exporting that catalog,
the project may no longer
display the correct items in the
imported catalog. Exporting and
then importing a project into a
new or different catalog
reassigns the project’s ID, so the
project may point to incorrect
items in the new catalog.
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To import a catalog:

1. Open the destination catalog, or create and open a new, empty
catalog.

2. Choose “Import…” from the Admin menu.

3. Check the settings in the “Add/Update Options” dialog box,
then click “Continue….”

4. In the file directory dialog box, select the exported file, then
click “Import.” Importing a catalog may take a significant
amount of time.

Removing items from a catalog

Together, the “Delete…,” “Purge…,” and “Volumes…” commands let
you clear the database of unwanted or out-of-date items or references.

Admin menu commands for removing items

Use this command… To…

Delete… Remove selected items outright.

Purge… Remove selected items whose source files you
suspect may no longer be available.

Volumes… Remove a volume reference from the catalog after
all items that referred to that volume have been
deleted.

Note: If you use any of these commands, Fetch will automatically purge any
unused keywords associated with the items or volumes that you have
removed.

To remove specific items from the catalog:

1. Select the items you want to delete.

2. Choose “Delete…” from the Admin menu.

3. Click “OK” to confirm the deletion.
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To remove items whose source files may no longer be
available:

1. In the Gallery or Pasteboard window, select the items that you
want to check.

2. Choose “Purge Items…” from the Admin menu.

Fetch tries to locate the source files for the selected items, then
displays the names of any it cannot find.

3. Select one or more items from the list box, then click “Purge.”

4. Click “Done” to close the dialog box.

To remove a volume whose items have all been deleted:

1. Choose “Volumes…” from the Admin menu.

In the “Volumes” dialog box, Fetch lists the names of all the
volumes referenced in the catalog.

2. Select a name from the list box, then click “Delete.”

3. Click “OK” to confirm the deletion, then click “Done” to close
the dialog box.

Decreasing catalog size after removing items

Removing items from a catalog does not decrease its file size. The
vacancy in the catalog created by the removed items still contributes
to the file size.

If you want to decrease your catalog’s file size after removing items,
you must export the catalog, create a new catalog, and then import the
exported catalog into the newly created one.
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Checking and recovering a damaged catalog

When you suspect that a catalog may be damaged, first try rebuilding
your desktop (press and hold down Option + Command while restart-
ing), then verify the catalog. As a last resort, if you have a catalog that
you cannot open at all, recover the catalog and import the recovered
contents into a new, empty catalog.

To verify a catalog:

1. Open the catalog.

2. Choose “Verify…” from the Admin menu.

3. Click “OK” in response to the prompt that asks you to confirm
that you want to verify.

Verifying a large catalog can take a long time, so you may want to
be sure that you are not tying up either the catalog itself or the
computer when you or others need them.

Fetch checks the catalog, performs any necessary repairs that it can,
and then informs you when the verification is complete. It shouldn’t
be necessary to verify catalogs often, but you might plan on doing it
once in a while for heavily used catalogs.

To recover the contents of a damaged catalog:

1. Open any existing catalog or create a new one.

2. Choose “Recover…” from the Admin menu.

3. Click “OK” in response to the prompt that asks you to close the
current catalog.

4. Click “OK” in response to the prompt that asks you to confirm
that you want to recover a catalog.

5. In the file directory dialog box, choose the name of the damaged
catalog, then click “Open.”

Recovery is often almost immediate. When recovery is finished, open
the recovered catalog, export its contents, and then import it into a new,
empty catalog.

Note: If you try to open a corrupted catalog or project, Fetch will
display a database error. You must then quit and restart Fetch before
you can open another catalog or project.
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Setting catalog privileges

An Extensis Fetch catalog is considered protected if a password is
required for access to the commands on the Admin menu or unpro-
tected if no password is required. Password protection is strongly
recommended when a catalog is available to multiple users across a
network, but not necessary if you are the single user of a catalog on
your own computer.

With Fetch, multiple users can open and search a protected catalog and
can preview, print, copy, or edit the items in it. They can also edit
keywords and descriptions at the discretion of a catalog administrator.
They cannot, however, add new items, update existing items, or delete
items from the catalog.

To set or change the password for a catalog:

1. Open the catalog.

2. Choose “Privileges…” from the Admin menu.

3. Click “Set Password…” in the “Privileges” dialog box.

4. In the “Set Password” dialog box, type the old password (if
there was one) and the new one twice.

The second time is to verify that the new password is correct. To
leave the catalog unprotected, the password should be blank.

5. Click “OK” once to close the “Set Password” dialog box, then
click “OK” again to close the “Privileges” dialog box and save
the new password.

6. Close the catalog and reopen it to put the changes into effect.

Once a catalog is protected by a password, only one command, “Enter
Password…,” appears on the Admin menu when you open the catalog.
Any user can open the catalog to find, preview, copy, edit, and print
catalog items. Only users who supply the correct password can perform
any of the administrative functions.

Tips

For more information about
network access to Fetch
catalogs, see the next section,
“Using Extensis Fetch on a
network.”

For help creating useful keywords
and descriptions for networked
catalogs, refer to the PDF file
“Developing a Keywording
Strategy” that was included with
your Fetch program.

You cannot set a password if
your user name is blank in the
Sharing Setup control panel.

If you need to know the
password for a catalog, you can
open the Catalog Info window to
find out the name of the last
person who set the password.

In a network environment, the catalog administrator who sets the
password can also specify whether or not other users can edit keywords
or descriptions. While in the “Privileges” dialog box, check:

• “Edit Keywords” to allow other users to edit keyword lists.

• “Description” to allow other users to edit descriptions.

The “Keywords…” and “Description…” commands on the Edit menu
appear dimmed to any user who does not have permission to edit
keywords and descriptions for the open catalog.
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Using Extensis Fetch on a network

A single Fetch catalog can contain references to source files on multiple
hard disks, servers, CD-ROMs, or floppy disks, whether these media
are mounted or not. When Fetch needs to retrieve a source file (for
copying or editing, for example) that resides on a network volume, it
automatically mounts that volume, prompting for a volume password
when required. If a source file is stored on removable media, such as
floppy disks or CD-ROM discs, Fetch prompts for the disk by name.
Fetch locates source files that have been moved or renamed on the
same volume. In a network environment, a shared catalog can be on a
network file server or on any one user’s Macintosh if the Macintosh is
running AppleShare.

Network Security Protection

Your license agreement authorizes you to use only one copy of Fetch
for serial number. When you run Fetch on a network, the program
checks the network to see whether a copy of the program using the
same serial number is already running. If the program finds that a
duplicate serial number is in use, an alert box appears. Click “OK” to
close the alert box. The other user must quit Fetch before you can
launch the copy that you want to use.

If the network fails while Fetch is checking for duplicate serial num-
bers, a few seconds may pass before the alert message appears.
Normally, the message appears almost immediately if a duplicate
number is found.

Using Fetch in a Network Environment

In a typical network scenario, many users would open Fetch, locate
items they want, and leave Fetch running in the background while they
switch to other applications to edit source files, work on other docu-
ments, read electronic mail, and so forth. Meanwhile, at any given time,
only some of those users would be actively using the catalog to search
for and preview items they might be interested in, while fewer still
might be adding or updating items, keywords, or descriptions.

The network version of Fetch allows only one user at a time to modify
(write to) the catalog—that is, edit keywords or descriptions or add or
update items—and temporarily prevents others from making modifica-
tions until that user is done. Other users can, meanwhile, continue to read
the catalog—search, preview, get information, copy, print, and so forth.
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Network access to catalogs and source files

For access to the… The folder that contains it…

Catalog Must be located in folders to which administrators have read and write access.
Other users need at least read access.

Source files Can be located in folders to which different users have different levels of
access.
No access allows users to search, print thumbnails, view thumb-

nails, send or copy references, edit keywords or descriptions
(if permitted), or view most item information.

Read access is required for users to get full item information, preview, print
images, copy items to the Clipboard, or copy source files.

Write access is required for users to edit, move, or delete source files.

The greater the number of users who have a catalog open, the slower
individual searches will be, depending on what the users are doing with
Fetch. The speed of the network and the server can also affect the
performance of Fetch.

If a user’s system crashes or is shut down while the user has a shared
catalog open, then Fetch will examine the catalog for damage and
temporarily make other users wait until the verification is complete.
Therefore, users should always close and quit to exit a catalog rather
than shut off or restart their systems.

If you want to limit who can write to the catalog, you can set a pass-
word as described in “Setting catalog privileges.” Whether or not your
catalog is password-protected in Fetch, it is essential that you also set
up the following network access conditions:

Note: Extensis offers a free browser to allow users who do not have the
Extensis Fetch program to view catalogs. If  you attempt to open a
catalog which has already been opened by someone using a Fetch
browser, you may not be able to open that catalog. If this happens, you
will be presented with a dialog box indicating that the file cannot be
opened until it is released by the browser.
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Naming source files

Use naming and organizing strategies together to make the most of
keyword searching in Fetch. Once you have decided how to organize
your files, consider the following alternatives for naming them:

• Use extensions to indicate file type, storage medium, status, or
any other attribute that is important to you.

• Use number or alphabetic prefixes to help sort items in ways that
matter for the kinds of files you use. For example, you might use
frame numbers for images from a single photo shoot or counter
or time code readings for sounds, movies, or images digitized
from video or audio tape.

Naming and organizing source files

There are many ways to organize the source files for items in an
Extensis Fetch catalog. Each strategy has advantages and disadvan-
tages, but considering the options and planning ahead can save you
time in the long run and significantly increase the usefulness of Fetch
to you and your workgroup.

One of the key benefits of using Fetch is that you do not need to remem-
ber where a source file is located or what it is called. However, because
Fetch can use filenames, folder names, or entire pathnames as keywords,
and because you can then use those keywords to help in searching, a
rational plan for naming and organizing files and folders is helpful.

Each workgroup must ultimately decide what works best for its own
situation based on how the group works and how work flows through it.
Here are a few suggestions that might help in your planning.

Organizing source files

One of the most obvious ways to organize files into folders is to set up
a series of folders for each project, client, or category (for example,
travel, business, architecture). Within a folder, use subfolders to
partition related files appropriately.

Another approach is to organize files into folders by file type, by
originating application, or by originating department (for example,
Marketing, Sales, Publications).

Once you’ve organized your files into folders, it’s easy to include the
files into catalogs in Fetch.
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QuarkXPress® 3.31 and above

To transfer images in Fetch to a QuarkXPress document
(QuarkXPress 3.31 or later):

Note: You must have the QX–Drag&Drop XTension (from your Fetch
Extras folder) installed in Quark’s XTension folder.

1. From an open Fetch catalog, select the image(s) you wish to
drop into your QuarkXPress document.

2. Drag the images over your open Quark document.

QX–Drag&Drop will place each image in a new picture box at the
cursor location in the document.

To attach a thumbnail to a QuarkXPress document:

1. When saving your QuarkXPress document, make sure that
“Include Preview” is checked in the QuarkXPress Save dialog
box.

This will save a black and white thumbnail of the first page of your
Quark document.

Note: Included with Extensis Fetch are “Lite” versions of two very
helpful Quark XTensions from Vision’s Edge. These are installed in the
Fetch Extras folder. “Touch” allows you to transfer images from a
Fetch catalog to a QuarkXPress image library. “Preview Editor”
allows you to save a full-color preview, keywords, and a description of
your Quark document. For instructions on using these products, please
refer to the product documentation in the Fetch Extras folder. For
technical support or to order these products, please contact Vision’s
Edge directly at (904) 386-4573 between 9:30 AM and 5:00 PM
Eastern time. Extensis does not offer technical support for either of
these products.

4—Using Fetch with Other Products

As you create multimedia files, you’ll find that Fetch works directly
with many products to make cataloging fast and easy. This chapter
describes how to use Fetch with various products.
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Adobe PageMaker 6.0 and 6.5

To transfer images in Fetch to a PageMaker 6.5 document:

1. Select the images in Fetch.

2. Drag the images to your PageMaker 6.5 document.

To transfer images in Fetch to a PageMaker 6.0 or 6.5
document:

1. Select the images in Fetch.

2. Choose “Copy Reference” from Fetch’s Edit menu and choose
“Include Thumbnails.”

The selected images are copied to the Clipboard.

3. In PageMaker, choose “Library Palette” from the Windows
menu. If you do not already have a library, you’ll be prompted
to create one.

4. In the library palette window, choose “Import Fetch Items”
from the Options menu.

The images you selected appear in the library palette. To place an
image in your PageMaker document, select it in the library palette
and drag it onto your document.

To include a thumbnail and preview in a PageMaker docu-
ment:

Choose “Save As...” from PageMaker’s File menu, and check
Save Preview in the “Save As...” dialog box. When you save the
file, a thumbnail and preview are created from the first page of
the document.

File Types

You can transfer the following
file types from Fetch into a
PageMaker Library Palette:
edtp, edtt, EPSF, PCDI, PICT,
PNTG, and TIFF.
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Adobe Photoshop 3.0 and 4.0

To include a thumbnail and preview to a Photoshop file:

1. In the Preferences menu in the Photoshop File menu, choose
“General...”

2. Click “More”

3. In the Image Previews section of the dialog box, select “Always
Save”

4. Click “OK”

To include keywords and captions in a Photoshop file:

1. Select “File Info” from the Photoshop File menu

2. Enter your caption in the caption field

3. Click “Next” to switch to the “Keywords” panel

4. Click “OK” to close the dialog box

Adobe Illustrator 6.0

Illustrator 6.0 automatically saves a thumbnail which Fetch displays.
However, you cannot preview the file in Fetch.  To create an Illustrator
6.0 file that you can preview, choose “Save As...” from Illustrator’s File
menu, and save the file as an EPS file. The EPS file contains both a
preview and thumbnail.

Adobe Persuasion 2.1 and 3.0

Persuasion automatically creates a thumbnail and preview for your file
when you save it. In Persuasion 2.1, the thumbnail and preview are
created from the first presentation master. In 3.0, they’re created from
the first slide.

To transfer a PICT or EPSF image from Fetch into Persuasion 3.0, use
Fetch’s “Send Reference” command. The image appears in the active
slide in Persuasion when in Slide View.
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Microsoft® Word and Other
Applications that Create Text Files

Fetch lets you preview the first 32,000 characters of any text file with a
file type of TEXT. A text file does not have a thumbnail, but will be
cataloged as a file icon. To preview a Microsoft Word document, you
need to save the file as a text file by choosing “Save As...” from the
File menu, then selecting “Text Only”, “Text Only with Line Breaks”
or “Text with Layout” from the drop-down list.

Macromedia FreeHand 5.5

To attach a thumbnail and preview in a FreeHand 5.5 file:

1. In the File menu, select “Preferences...”

2. Select “Importing/Exporting.”

3. Check “Include Fetch™ preview.”

When you save the file, a vector PICT thumbnail and preview are
created, increasing the size of your file. If your file has small
dimensions, contains tiled fills, or is crowded with many objects,
you can select “Bitmap Fetch™ preview size” to minimize the
increase.
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Finder shortcuts

To do this… Use this shortcut…

Add item to default catalog Drag file over Fetch icon when Fetch is not running.

Add item to another catalog Drag file over Fetch icon when Fetch is running and catalog is open.

General window shortcuts

To do this… Use this shortcut…

Open Find window Press Command + F.

Open Gallery window Press Command + R.

Open Pasteboard window Press Command + B.

Open Catalog Info window Double-click left end of information bar in Gallery or Pasteboard window.

Open Preview window Double-click thumbnail. Or select item, then press Return or Command + J.

Open Info window Double-click filename. Or select item, then press Command + I.

Close active window Click close box. Or press Command + W.

Close all secondary windows Press Option + click close box.

Close all windows (and catalog) Press Option + Command + W.

Appendix A: Summary of Extensis Fetch Shortcuts

For an online reference to Extensis Fetch shortcuts, choose “Fetch
Shortcuts” from the Help menu.
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Find window shortcuts (most also work where applicable in search definition
dialog boxes)

To do this… Use this shortcut…

Open Find window or bring to front Press Command + F when Find window is not open or not active.

Open and clear Find window Press Command + Delete.

Retrieve everything in the catalog Press Command + ' (apostrophe).

Expand Find window Press Command + M when Find window is open, active, and reduced.
 (“More Choices” )

Reduce Find window Press Command + F when Find window is open, active, and expanded.
(“Fewer Choices” )

Clear search descriptions (“Clear” ) Press Command + Delete, or click “Clear” when Find window is open and  active

Repeat previous search Press Command + , (comma).

Carry out default search Press Command + D.

Define, name, and save search Press Command + K.

Gallery and Pasteboard window shortcuts

To do this… In Thumbnail view In Text List view

Open Gallery window Press Command + R. Press Command + R.
or bring to front

Open Pasteboard window Press Command + B. Press Command + B.
or bring to front

Scroll to beginning or end Press Home or End. Press Home or End.
of window

Scroll up or down one screenful Press Page Up or Page Down. Press Page Up or Page Down.

Select item Click thumbnail or text below thumbnail. Click row in list box.

Select next item in direction chosen Press any arrow key. Press up or down arrow key.

Select additional item Press Command + click new item. Press Command + click new item.
(discontiguous)

Select all items between last Press Shift + click new item. Press Shift + click new item.
and current item

Select all items in window Press Command + A. Press Command + A.

.

More ➥
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Gallery and Pasteboard window shortcuts  (continued)

To do this…                                  In Thumbnail view                              In Text List view

Copy item from Gallery to Press Control + click thumbnail. Or Select item, press Control + click
Pasteboard window select item, then press Command + M. thumbnail or press Command + M.

Copy item to Clipboard Select item, then press Command + C. Select item, press Command + C.
(single item only)

Copy item reference to Clipboard Select item, then press Command + H. Select item, press Command + H.
with text (multiple selection OK)

Remove item from catalog Select item, then press Delete. Select item, then press Delete.

Remove item from primary window Select item, then press Clear. Select item, then press Clear.

Open Preview window Double-click thumbnail. Or select Select item, double-click thumbnail,
thumbnail, press Return or Command + J. or press Return or Command + J.

Open Preview window with faster Hold down “G” key while choosing Hold down “G” key while choosing
scrolling and zooming “Preview” from Item menu. “Preview” from Item menu.
with 32-bit images Hold down “G” key and press Return Hold down “G” key and press Return

to preview selected item. to preview selected item.

Switch to editing application last Press Option + double-click thumbnail. Select item, then press Option +
associated with item’s file type and Or select item, then press Command + G. double-click thumbnail or press
creator Command + G.

Switch to another editing application Select item, then press Select item, then press
Option + Command + G. Option + Command + G.

Open Info window Double-click text below thumbnail. Double-click row in list box.
Or select item, press Command + I. Or select item, press Command + I.

Open Catalog Info window Double-click left end of information bar. Double-click left end of information
 bar.

Open Find window Double-click middle of information bar. Double-click middle of information
(or bring to front) Or press Command + F. bar. Or press Command + F.

Change view Double-click “Thumbnail View” in infor- Double-click “Text List View”
mation bar. Or press Command + L. in information bar. Or press

Command + T.

Print thumbnails of all items Press Command + P. Press Command + P.
 in window
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Preview window shortcuts: still images (including KODAK Photo CD images)

To do this… Use this shortcut…

Increase magnification and window size Press Command + + (plus sign).

Increase magnification and maintain window size Press Shift + click image.

Decrease magnification and window size Press Command + - (hyphen or minus sign).

Decrease magnification and maintain current window size Press Option + click image.

Return image to actual size (100%); adjust window to fit Press Command + ` (accent).

Return image to actual size; maintain window size Press Shift + Option + click image. 

Select a portion of the image Drag crosshair cursor over desired part of image, then
release.

Zoom in on a portion of the image Shift + drag a selection area. 

Pan image within Preview window Press Command + drag.

Scroll up or down within Preview window Press Page Up or Page Down.

Scroll left or right within Preview window Press Option + Page Up or Page Down.

Scroll to top left or bottom right corner of window Press Home or End.

Scroll a little bit up, down, right, or left Press appropriate arrow key.

Copy item to Pasteboard window Press Command + M.

Copy item to Clipboard Press Command + C.

Copy item reference to Clipboard with text Press Command + H.

Switch to default editing application Press Command + G.

Switch to another editing application Press Option + Command + G.

Return to Gallery window Double-click image. Or press Command + R.

Open Info window (KODAK Photo CD images) Double-click middle of information bar. Or press
Command + I.

Open Info window (other types of images) Double-click in information bar. Or press Command + I.

Print image Press Command + P.

Open popup menu (KODAK Photo CD images only) Press and hold down mouse button on the little arrow in
the information bar.
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Catalog Info window shortcuts

To do this… Use this shortcut…

Find all items that use a keyword Double-click that keyword.

Refresh keyword list Double-click “Keywords.”

Save master keyword list as a text file Choose “Export…” from Admin menu.

Toggle keyword list order Press Option and click “keywords.”
(alphabetical or frequency)

Preview window shortcuts: movies, sounds, animations, and PICS

To do this… Use this shortcut…

Select a frame Click play bar.

Select all frames between last and current frame Shift + click play bar. Or press Shift + drag across slider.

Play or stop movie or sound Press Spacebar. Or double-click to play, single click to
pause.

Step forward or backward one frame Press right or left arrow key.

Go to first or last frame Press Home or End.

Increase or decrease volume Press up or down arrow key.

Copy item to Pasteboard window Press Command + M.

Copy item to Clipboard Press Command + C.

Copy item reference to Clipboard with text Press Command + H.

Switch to default editing application Press Command + G.

Switch to another editing application Press Option + Command + G.

Return to Gallery window Press Command + R.

Open popup menu Press and hold down mouse button on the little arrow in
the information bar.

Open Info window Double-click middle of information bar. Or press
Command + I.

Hide or display QuickTime control bar (movies only) Press Tab.

Display QuickTime control bar (movies only) Click badge (if present).
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Info window shortcuts

To do this… Use this shortcut…

Display next or previous page of File Info or Fetch Info field Tab key for File Info. Tab + Shift for Fetch Info.

Edit description (noneditable portion is in italics) Double-click “Description.” Or press Command + U.

Find all items that use a keyword Double-click that keyword.

Toggle keyword list order (alphabetical/frequency-of-use) Press Option + click “Keywords.”

Edit keyword list (noneditable keywords are in italics) Double-click “Keywords.” Or press Command + Y.

Open Preview window Double-click thumbnail. Or press Return or Command + J.

Copy item to Pasteboard window Press Command + M.

Copy item to Clipboard Press Command + C.

Copy item reference to Clipboard with text Press Command + H.

Switch to default editing application Press Command + G.

Switch to another editing application Press Option + Command + G.

Return to Gallery window Press Command + R.

Return to Pasteboard window Press Command + B.
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Index

A
“Add to Exclusions” command 48–49
“Add/Update Items…” command 41–49
“Add/Update Options” dialog box 45
Adding

descriptions 58–59
file types 50–53
files 41–44
folders 42–43, 44
items

to catalogs 41–44
to other applications 28–30
to Pasteboard window 35

keywords 56, 57
Administrator 60–66

catalog maintenance 60–62
setting catalog privileges 64–66

Adobe Illustrator 71
Adobe PageMaker 70
Adobe Persuasion 71
Adobe Photoshop 71
Aliased folder 43
Animation

file types 53
previewing 21
shortcuts 77

Archiving. See Cataloging

B
Backing up

catalogs 60–62
Balloon Help 8
Basics, Extensis Fetch 8, 9
Bitmap. See Image

C
Catalog

adding items 41–44
creating

by dragging 41
by selecting 41

deleting items from 61
destination 60
editing. See Editing
excluding files from 48–49
exporting 60
importing 61
maintaining 60–62
opening 9
protecting 64–66
retrieving items from 13–14
searching.See Searching
setting privileges 64–66
source 60

“Catalog Info…” command 31
Catalog Info window 17, 31, 77
Cataloging

adding new catalogs 39–47
creating catalogs 39–47
description.See Description
excluding files 48–49
keywords.See Keywords
maintenance 60–62
setting update options 45–47
updating 41–47

“Choose…” button in “File Types” menu 50
Clipboard, copying to 17, 18, 20, 21, 23
Color QuickDraw 34
“Compressor Criteria” option 46, 47
“Compressor Type” option 46, 47
“Copy” command 27, 29
“Copy Original…” command 24–26
“Copy Reference” command 27
Copying

items 27–30
movie file 29
sound file 29
source file 25, 26
still image 29

Creating
projects 36

Customizing searches 14–16
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D
Decrease

catalog size 62
magnification 20

Defaults
catalog 33
document 33
measurements 34
search 15, 16, 33

customizing 15, 16
editing 33

window 33, 34
“Define…” command 33
Defining searches 15
“Delete…” command 61
“Delete Original…” command 24, 26
Deleting

items 61–62
source files 24, 26

Description
editing 32, 58–59
extracting 46, 58
in searches 14
of Extensis Fetch 1
unknown file type, selecting 50–53
using 58–59

“Description…” command 59
Destination catalog 60
Dithering images 34
Dragging

to copy an item 25, 28
to create catalogs 39
to place an item in a catalog 41
to place an item in a document 28
to update catalogs 41–45

E
Easy Open.See Macintosh Easy Open
“Edit Description” dialog box 58–59
“Edit Keywords” dialog box 47, 54–57
“Edit Original” command 24–26
Editing

descriptions 32, 58–59
keyword lists 54–57, 64
source files 17, 24–26

“Enter Password…” command 64
EPSF image 29, 52
Excluding files from catalogs 48–49
“Exclusions…” command 48–49
“Exclusions” dialog box 49
Exporting

catalogs 60
master keyword list 54

Extensis Fetch
administering 60–66
Balloon Help 8
installing 2
interapplication connectivity

  27–30, 69–72
learning 8, 9
online help.See Help
personalization and registration 3-4
prefs file 3
starting 9
Technical Support 4
User Manual 8
using on network 65–66

Extensis Fetch drag and drop.See “Dragging”
Extracting information from source files 54

F
Fax modem, using in printing 37
“Fetch Shortcuts” command 8
Fetch-awareness 27–30
File

adding 41–42
adding unknown file type 50
excluding from catalogs 48–49
source file, naming 67
transfering 29

File types
adding 50–53
modifying 51
searching by 13–14

“File Types…” command 50–53
“File Types” dialog box 50–53
Filename

searching using 13–14, 15
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Find window 13, 14
expanded, for complex searches 14
keyboard shortcuts 74
retrieving items using 12–15

Finder
adding items to catalogs 41–44
creating catalogs 39–40

Finding. See Searching
Folder

adding 42, 46
aliased 43
name as keyword 46

Freehand 72

G
Gallery window

described 10
displaying results of search 13
opening 11
shortcuts 74–75
Text List view 10, 18
Thumbnail view 10, 16

H
Hardware requirements 1
Help

Fetch Shortcuts 73–78
online

Balloon Help 8
Fetch Shortcuts 8
ReadMe file 8

I
Illustrator 6.0 71
Image. See also KODAK Photo CD

copying 27–30
EPSF 29
movie 29
SND 29

file types 50–53
magnification 20, 23
previewing 20–23
shortcuts 76

Importing catalogs 61
Increase magnification 20
Info window 9, 17, 31–32, 78
Interapplication connectivity 27–30, 69–72
Item

adding to catalogs 58–59
adding to Pasteboard window 35
copying to other applications 27–30
dragging into another application 28
editing source files 24–26
information for 31–32, 54
retrieving 12–14
searching using Find window 13–14
thumbnail 17

J
JPEG compression 46, 47
Jump to first or last frame 21

K
Keyboard shortcuts.See Shortcuts
Keywords

adding multiple 56
Add/Update options 46
deleting multiple 57
editing 47
editing lists 32, 54–57
extracting 46, 54
list in Info window 32
master list

exporting 54
in Catalog Info window 31

order 31
preferences, setting 34
searching using 13, 15
toggle order 31

KODAK Photo CD
file type 53
playing in Preview window 19, 22
previewing images 22
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L
LaserWriter driver 38
Learning Extensis Fetch 5-8
Library. See Catalog
Locating. See Searching

M
Macintosh Easy Open 3
Macromedia Freehand 72
Magnification of images 20, 23
Maintenance, catalogs 60–62
Measurement system, default 34
Memory

RAM 17
requirements for QuickTime 1

Microsoft Word 72
Modem, printing to fax 37
“Modification Status” box 43
“Move Original…” command 24–26
Movie

playing in Preview window 19–20, 21
references 29
setting preferences 34
shortcuts 77

Moving source files 24–26
Multiple users 64, 65–66

N
“Name” edit box 51
Naming source files 67
Network. See also Administrator

catalog privileges 64
ReadMe 8
security 65
using Fetch on 65–66

O
Online help

Balloon Help 8
ReadMe file 8
Shortcuts 8

“Open…” command 9, 36
“Open Project…” command 36

Opening
catalogs 9
Fetch 9
Find window 13
information windows 31, 32
Preview windows 19–23
projects 36
windows, shortcuts 11, 73–78

P
PageMaker 70
Pasteboard window 35
Pause

movie 21
sound 22

Persuasion 3.0 71
Photo. See Image. See also KODAK Photo CD
Photoshop 71
PICT format 29, 53
Play

movie 21
sound 22

Preferences
setting 33–34

Preview window 9, 19–23, 76
Previewing items 19–23
“Print…” command 37
Printing 37

images 37
options 37
master keyword list 57
thumbnails 37
troubleshooting 38
using fax modem 37

“Privileges…” command 64–66
“Privileges” dialog box 64–66
Project, Fetch 36
Protection, network security 65
“Purge…” command 61
Purging items 61



83

Q
QuarkXPress 69

draggging items to 28
QuickDraw requirement 34
QuickDraw 3D 23

file type 53
QuickTime

file type 53
playing in Preview window 19, 21
previewing 21
shortcuts 76

QX–Drag&Drop 28, 69

R
RAM 1, 17
ReadMe file 8
Reference 27

copying 27, 29–30
sending 29–30
transferring 29–30

Removing items.See Deleting. See also Purging
Reordering items 17, 18
Retrieving items 12–14.See also Searching

S
Sample catalog

updating 7–8
using 7

“Save As Project…” command 36
Search definition 15
Searching

by file type 13–14
by filename 14, 15
by keywords 13
by volume 13–14
complex searches 14
default search 33
defining searches 12–14
faster 15
keyboard shortcuts 13, 15, 74
“not” operators 13, 14
simple searches 14
using Find window 13
viewing results 15, 12–16

Security, network protection 65
Select

cropping image 20
item 17, 18
part of movie 21

“Send Reference” command 27
Setting

catalog privileges 64–66
Shared work environment.See Network, using

Fetch on
Shortcuts 73–78

animation 77
Catalog Info window 77
deleting 49
Find window 74
Gallery window 74–75
Info window 78
movies 77
online 8
opening catalogs 11
opening windows 11
Pasteboard 74–75
Preview window 19, 76
searching for items 13, 15
sound 77
still images 76
windows 73, 78

“Show Balloons” command 8
Single-User catalog

converting for use in Fetch 1.5 12
Size

catalog 47, 62
preview image 20

SND format 29
Software/hardware requirements 1
Sound

file types 52
playing in Preview window 19, 22
previewing 22
shortcuts 77

Source catalog 60
Source file 17, 24–26
Starting Extensis Fetch 9
Still image. See Image
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T
Text applications 72
Text List view 10, 18

shortcuts 74
viewing search results in 18

Thumbnail
display options 46, 47
editing descriptions 58–59
editing keywords 54–57
in Info window 32
printing 37
printing using fax modem 37
in projects 36
View 17

Thumbnail view 10, 17, 74
TIFF image, file types 53
Toggle keyword order 31
Transferring items to other applications 27–30
Troubleshooting

adding unknown file type 50
damaged catalogs, repairing 63
printing problems 38
repairing damaged catalogs 63
updating, problems with corrupt items 43

U
Updating catalogs 60–62
User Manual 8

V
“Verify…” command 63
Viewing

Pasteboard window contents 35
search results     16, 12–15
Windows 9-11, 14, 31-32, 35

Volume
adding 42
searching by 13–15

W
Windows

Catalog Info 31
Described 9-11
Find 9
Gallery 73
Info 9, 78
keyboard shortcuts 73–78
Pasteboard 35, 74
Preview 9, 19–20, 76
Primary 10
Secondary 11
Shortcuts 11, 13, 73–78

Workgroup
administration 60–62
network, Fetch on 65–66

Working with other applications
       27–30, 73–78

Z
Zooming in on images 20



Registration

If you haven’t already registered, please complete the following registration information, tear
along the perforation and fax to (503) 274-0530 or drop it in the mail in the postage-paid
envelope provided. Your product registration number is located on the Extensis Fetch™ manual.

____________________________________________________________________________________
Name

____________________________________________________________________________________
Street Address

____________________________________________________________________________________
City State Country Zip/Postal Code

____________________________________________________________________________________
Daytime Phone Daytime Fax

____________________________________________________________________________________
E-mail (optional) CIS AOL A-Link Internet Other

Hardware Configuration (check all that apply)
❐ PowerMac ❐ Quadra ❐ Mac II any ❐ PowerBook
❐ CD-ROM ❐ Modem ❐ Scanner ❐ Network
❐ Do you also use a PC running Windows?❐ QuarkXPress for Windows

Fetch Experience (check one)
❐ <6 months ❐ 6 mo. – 1yr. ❐ 1 yr. – 2 yrs. ❐ 3 – 4 yrs. ❐ >4 yrs.
Number of personal computers at site (check one)
❐ 1 ❐ 2–5 ❐ 6–10 ❐ 11–25 ❐ 26–50 ❐ >50
How did you learn about Extensis Fetch? (check all that apply)
❐ Advertisement ❐ Review ❐ Bundle ❐ Demo ❐ Dealer
❐ Word-of mouth ❐ User Group ❐ Direct Mail ❐ Other_______________________

Where did you purchase Extensis Fetch? _______________________________________________

What publications do you read? (check all that apply)
❐ MacWorld ❐ MacUser ❐ MacWEEK ❐ Adobe ❐ Publish
❐ X-Ray ❐ Other ______________________________________________________

Other Graphics/Publishing Applications Used? (check all that apply)
❐ QuarkXPress ❐ PageMaker ❐ Photshop ❐ Illustrator ❐ Freehand
❐ Live Picture ❐ Painter ❐ XRes ❐ PhotDeluxe ❐ Canvas
❐ Director ❐ Premiere ❐ Quark Immedia❐ Final Effects ❐ KPT
❐ Bryce ❐ Convolver ❐ Vector Effects ❐ Acrobat Exchange ❐ Extreme 3D
❐ After Effects ❐ Ray Dream ❐ Alien Skin Stylist ❐ Infini-D ❐ DeBabelizer
❐ PageMill ❐ Netscape ❐ MS Inet. Explorer❐ Andromeda ❐ ScanPrepPro
❐ The Black Box ❐ TyperCaster ❐ VE Act ❐ XPert Tools ❐ Finger Type
❐ Shadow Caster ❐ Flight Check ❐ MS Word ❐ MS Excel ❐ ClarisWorks
❐ FileMaker ❐ Quicken ❐ One Click ❐ Norton Utilities ❐ Now Utilities





Suggestion

We’d like to know what you think we could do to make Extensis Fetch™ better. So if you
have an idea for a new product feature, a modification to an existing one, or anything else you
can think of that will help us make Extensis Fetch better—we’d like to hear from you.

To help make Extensis Fetch better, please...

1. Print your name, address, and phone number below and sign your name.

2. Describe your idea or comment.

3. Tear along the perforation and mail or fax this sheet to Extensis.

I understand that no compensation will be awarded for my suggestion.

My suggestion is...

.....................................................................................................................................................................

.....................................................................................................................................................................

.....................................................................................................................................................................

.....................................................................................................................................................................

.....................................................................................................................................................................

.....................................................................................................................................................................

.....................................................................................................................................................................

____________________________________________________________________________________
Name

____________________________________________________________________________________
Street Address

____________________________________________________________________________________
City State Country Zip/Postal Code

____________________________________________________________________________________
Daytime Phone Daytime Fax

____________________________________________________________________________________
E-mail (optional) CIS AOL A-Link Internet Other

Thanks for your suggestions! Hopefully you’ll see your ideas in future versions of Extensis
Fetch or other Extensis products.




